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Security Design with Arm® TrustZone® - IP
Protection

Introduction

Arm® TrustZone® technology for ARMv8-M is an optional security extension that is designed to provide a
foundation for improved system-level security in a wide range of embedded applications. This application
note explains the various RA MCU TrustZone technology enabled hardware and software features and
provides guidelines for using these features. In addition, this application project provides step-by-step
instructions to kickstart TrustZone technology enabled secure system design with Renesas RA Family
MCUs.

For fundamentals of Arm TrustZone Technology, users are encouraged to read the document Arm®
TrustZone Technology for the Armv8-M Architecture from Arm. This application project focuses on the
TrustZone technology implementation and features for RA Family MCUs with TrustZone support. At the time
of release, the RA MCU groups that are covered by this application project includes the MCU groups with
support both TrustZone and Device Lifecycle Management, for example, RA6M4, RA6M5, RA4M3, RA4M2,
RAGBE1, RA4E1 and RA6T2. Support for the MCU groups which do not include Device Lifecycle
Management will be added in future release.

Creating a secure design involves using hardware enforcement, software development for security, and
tooling support. For TrustZone based security design, tooling plays a critical role for the development,
production, and deployment of a product. For the tools support, refer to the ESP User’s Manual section:
Primer: TrustZone Project Development prior to proceeding to TrustZone based development.

An EK-RA6M4 based application project implementing an IP protection use case for TrustZone technology is
provided as a reference project to start application development with the RA Family MCU TrustZone feature.
Implementations with e? studio, IAR EWARM and Keil MDK IDEs are provided with instructions on how to
import and run the example projects.

Required Resources
Software and development tools

e 2 studio IDE v2023-10
e Renesas Flexible Software Package (FSP) v5.0.0
e Renesas Advanced Smart Configurator v2023-10

The links to download the above software are available at https://github.com/renesas/fsp.
e |AR Embedded Workbench for Arm version v9.40.2 or later
(https://www.iar.com/products/architectures/arm/iar-embedded-workbench-for-arm/)
e Keil MDK v5.38
(https://www.keil.com/download/product/)
e SEGGER J-Link® USB driver 7.92j or later (SEGGER J-Link)
e Renesas Flash Programmer (RFP) v3.11.01

Hardware

o EK-RA6M4, Evaluation Kit for RA6M4 MCU Group (renesas.com/ra/ek-ra6m4)
¢  Workstation running Windows® 10 and the Tera Term console or similar application.
e One USB device cable (type-A male to micro-B male)
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Prerequisites and Intended Audience

This application project assumes that you have some experience with the Renesas e? studio IDE, IAR
EWARM as well as Keil MDK IDEs. In addition, user is expected be able to understand how to extract the
generated content from FSP and Renesas RA Smart Configurator. In addition to reading the two reference
documents mentioned in the Introduction section, we recommend reading the first two chapters of the
application note Renesas RA Family Installing and Utilizing the Device Lifecycle Management Keys to
understand the Device Lifecycle States of RA TrustZone technology enabled MCUs. Furthermore, users
must know how to enter MCU boot mode using the EK-RA6M4 and create a basic RFP project to
communicate with the MCU. This application project only provides necessary settings for the specific
functions used in this application project. For more information on the MCU boot mode and RFP, refer to the
Renesas RA6M4 Group User’s Manual: Hardware and Renesas Flash Programmer User’'s Manual.

The intended audience is all users who are or will be developing Arm® TrustZone® based applications using
Renesas RA Family MCUs.
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1. Introduction to Arm® TrustZone® and its Security Features

1.1 TrustZone Technology Overview

Arm TrustZone technology is a hardware-enforced separation of MCU features. Arm TrustZone technology
enables the system and the software to be partitioned into Secure and Non-secure worlds. Secure software
can access both Secure and Non-secure memories and resources, while Non-secure software can only
access Non-secure memories and resources. These security states are orthogonal to the existing Thread
and Handler modes, enabling both a Thread and Handler mode in both Secure and Non-secure states.

Processor States

Thread mode Thread mode

Handler mode Handler mode

Figure 1. Processor States

The Armv8-M architecture with Security Extension is an optional architecture extension. If the Security
Extension is implemented, the system starts up in the Secure state by default. If the Security Extension is not
implemented, the system is always in the Non-secure state. Arm TrustZone technology does not cover all
aspects of security. For example, it does not include cryptography.

In designs with Armv8-M architecture with Security Extension, components that are critical to the security of
the system can be placed in the Secure world. These critical components include:

e A Secure boot loader

e Secret keys

e Flash programming support
e High value assets

The remaining applications are placed in the Non-secure world.

Non-trusted

Figure 2. Secure and Non-secure Worlds
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As mentioned in the Introduction section, for more details on the definition and usage of TrustZone®, see the
Arm document, Arm TrustZone Technology for the Armv8-M Architecture.

1.2 RA MCU Hardware Enforced Security using Arm TrustZone

To build a Secure hardware platform, the security considerations need to go beyond the processor level.
Renesas RA Arm TrustZone enabled MCUs extend the security arrangement to the entire system including:

e Memory system

e Bus system

e Access control to Secure and Non-secure peripherals
e Debug system

Note that the RA6M4 MCU Groups are used as a reference in this section. Other TrustZone technology
enabled MCUs may have some variations in terms of the details for the hardware features.

1.2.1 Memory Separation

Code flash, data flash, and SRAM on RA TrustZone technology enabled RA MCUs are divided into Secure
(S), Non-secure (NS), and Non-secure Callable (NSC) regions by way of the IDAU (Implementation Defined
Attribution Unit). These memory security attributes are programmed into the nonvolatile memory using serial
programming commands when the device lifecycle is in the Secure Software Development (SSD) state. For
the Device Lifecycle State definition and transitions, see the Renesas RA6M4 Group User's Manual:
Hardware section, Security Features.

Figure 3 shows a summary of the 8 available regions.

Code Flash Data Flash SRAM

Non-Secure Non-Secure Non-Secure

Mon-Secure callable MNon-Secure callable

0x0000_0000 0x2000_0000

Figure 3. IDAU Regions
Code and Data Flash TrustZone® Based Security Features

Code and Data flash regions read from a Non-secure region will generate a TrustZone Secure Fault. Per the
MCU design, the Code and Data Flash Programming and Erasing (P/E) mode entry can be configured to be
available from only Secure software or from both Secure and Non-secure software.

By default, the MCU configures the Code and Data Flash P/E functionality available only from Secure
software. The flash driver may be placed in the Secure partition and may be configured as Non-secure
Callable through the FSP to allow the Non-secure application to perform flash P/E operations.

Table 1. Secure Flash Region Read/Write Protection

Access Violation Error Report
Flash read TrustZone Secure Fault: Reset or Non-Maskable Interrupt (NMI).
Flash P/E mode entry Flash P/E Error Flag: Handled by FSP flash driver.

RA Family MCUs support temporary and permanent Flash Block Protections for both the Secure region and
Non-secure region. For more details on the Code and Data Flash TrustZone technology enabled hardware
features, see the Renesas RA6M4 Group User's Manual: Hardware, Flash Memory section.

SRAM

SRAM memory, such as SRAMO, that includes an ECC region and Parity can be divided into Secure/Non-
secure Callable/Non-secure regions with Memory Security Attribution (MSA) and can be protected from Non-
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secure access. When MSA indicates that an SRAM memory region is of Secure or Non-secure Callable
status, Non-secure access cannot overwrite them.

Table 2. Secure SRAM Region Read/Write Protection

Access Violation Error Report
SRAM read Arm® TrustZone Secure Fault: Reset or NMI
SRAM write Arm TrustZone Secure Fault: Reset or NMI

1.2.2 Bus System Separation

The IDAU region setup is consistent for the CPU, Direct Memory Access Controller (DMAC), and Data
Transfer Controller (DTC). Master TrustZone filters are implemented for the DMAC and DTC.

1.2.2.1 Master TrustZone Filter for DMA Controller and Data Transfer Controller

The DMAC and DTC are supervised by the Master TrustZone Filter. The TrustZone violation area of Flash
and SRAM is detected in advance before accessing the bus. The Master TrustZone Filter in the DMAC or
DTC can detect the security areas of Flash area (code Flash and data Flash) and SRAM area (ECC/Parity
RAM) defined by IDAU. When a Non-secure channel accesses those addresses, the Master TrustZone Filter
detects the security violation. Access to the address in violation is not granted. For both DMAC and DTC, the
detected access violation is handled as the “Master TrustZone Filter error”. A DMA_TRANSERR interrupt will
be generated in response to the “Master TrustZone Filter error”.

Below are some additional comments on the DMAC security attribute:

e The Security Attribution can be configured individually for each channel. Each DMA channel can assume
Secure or Non-secure attribute.

e Only Secure code can configure whether the DMAC can be started by Secure or Non-secure code.
— If the DMAC is used in the Secure project, the FSP will start DMA in Secure mode and disable a
Non-secure project from accidentally stopping the DMAC by setting up the corresponding registers.

1.2.2.2 Ethernet DMA Controller (EDMAC)

The RA6M4 MCU requires EDMAC RAM buffers to be placed in TrustZone Non-secure RAM. The EDMAC
is hard-coded as a TrustZone Non-secure bus master. These hardware features allow the following Ethernet
code partitioning options:

¢ Run Ethernet code as Secure and EDMAC RAM buffer in Non-secure RAM.
¢ Run Ethernet code and EDMAC RAM buffer in Non-secure region.

The FSP supports implementations with both options.

1.2.2.3 Bus Master MPU TrustZone® Feature

The Bus Master MPU is available for memory protection function for each bus master except the CPU.
Secure software can set up the security attributes of the Bus Master MPU.

Refer to the Renesas RA6M4 User’s Manual: Hardware and FSP User’'s Manual for more details of the
security attribute control for the bus systems.

1.2.3 10 and Peripheral Separation

Most peripherals in the MCU can be configured to be Secure or Non-secure with several exceptions as
shown in Table 3.
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Peripherals are divided into two types:

e Type-1 peripherals have one security attribute. Access to all registers is controlled by one security
attribute. Type-1 peripheral security attributes are written to the Peripheral Security Attribution Registers
(PSARX: x = B to E) by the Secure application.

— e? studio and the FSP provide a convenient way to assign the PSARX.
— Different channels for the peripheral can assume different security attributes. For example, UART
Channel 0 and Channel 1 can have different Secure or Non-secure attributes.

e Type-2 peripherals have the security attributes for each register or for each bit. Access to each register
or bit field is controlled according to these security attributes. Type-2 peripheral security attributes are
written to the Security Attribution register in each module by the Secure application. For the Security
Attribution register, see sections in the user manual for each peripheral.

— e? studio and the FSP provide configurability for most of these peripherals with several exceptions
where sensible default settings have been made to provide a better development experience.
— See the latest FSP User’s Manual for details for each peripheral.

Table 3. List of Type-1 and Type-2 Peripherals

Type Peripheral

Type 1 SCI, SPI, USBFS, CAN, IIC, SCE9, DOC, SDHI, SSIE, CTSU, CRC, CAC, TSN,
ADC12, DAC12, POEG, AGT, GPT, RTC, IWDT, WDT

Type 2 System control (Resets, LVD, Clock Generation Circuit, Low Power Modes,

Battery Backup Function), Flash Cache, SRAM controller, CPU Cache, DMAC,
DTC, ICU, MPU, BUS, Security setting, ELC, 1/O ports

Always Non-secure CS Area Controller, QSPI, OSPI, ETHERC, EDMAC

The access permissions of type-2 peripherals are different by peripheral. See the Register Description
section of each peripheral.

Table 4. Peripheral Access Control Based on Arm TrustZone

Permission Secure access | Non-secure access

Peripheral configured as Secure Allowed Write is ignored; read is ignored. TrustZone
Access error is generated.

Peripheral configured as Non-secure | Allowed Allowed

Notes on Clock Generation Circuit (CGC)

The Clock Generation Circuit has individual security attributes for each of the clock tree controls. The current
release of the tooling and FSP provides flexibility of the following clock control schemes:

e Entire clock tree is controlled from the Secure project only and locked down in the Non-secure project.
e Entire clock tree is controllable from the Non-secure project as well as the Secure project.

Refer to Notes on Clock Control for the operational details.

Peripherals that Support Non-secure Partition Operation Only
As shown in Table 3, the following three peripherals have limitations in terms of their security attributes:

e Ethernet: See Section 1.2.2 for the limitations on Ethernet application development.

e CS Area Controller, QSPI, OSPI: These peripherals are Non-secure peripherals only. The FSP has
support for them to be used from all three project types. Refer to section 4 for the definitions of project
types based on the Project Configurator.
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1.2.4 Debug Interface

For the Arm® TrustZone® technology enabled RA Family MCUs, the debug function is considered in three
levels (DBGO, DBG1, and DBGZ2) to support TrustZone technology enabled debugging and provide security
in development, production, and deployed products:

e DBG2: The debugger connection is allowed and there is no restriction to accessing memories and
peripherals.

e DBGL1: The debugger connection is allowed and restricted to access only Non-secure memory regions
and peripherals.

e DBGO: The debugger connection is not allowed.

Debug level is determined corresponding to the device lifecycle state of product. See the Renesas RA6M4
Group User’'s Manual: Hardware chapter on Security Feature section Device Lifecycle Management for more
details.

Debug level regression is possible through the Device Lifecycle Management system. See the application
note Renesas RA Family Installing and Utilizing the Device Lifecycle Management Key for the corresponding
operational flows.

For Renesas RA TrustZone technology enabled MCUs, J-Link, E2, and E2 Lite debuggers are supported.

1.3 Device Lifecycle Management

The RA Family TrustZone technology enabled MCUs incorporate an enhanced Device Lifecycle
Management System using TrustZone technology features and Secure Crypto Engine 9 (SCE9). Device
Lifecycle Management is important during TrustZone technology enabled application development,
production, and deployment stages.

For Device Lifecycle State definition and transitions, see the Renesas RA6M4 Group Hardware User’s
Manual. For creation, installation, and use of the Device Lifecycle Management keys during development
and production stages, see the application note Renesas RA Family Installing and Utilizing the Device
Lifecycle Management Keys.

1.4 Example TrustZone Use Cases

This application project explains two specific use cases for TrustZone technology and provides an example
software project for the IP Protection use case.

For additional attack scenarios where an attacker may attempt to access protected information and how the
TrustZone technology for ARMv8-M can prevent them, see Chapter 2, Security of Arm® TrustZone
Technology for the Armv8-M Architecture.

1.4.1 Intellectual Property (IP) Protection

IP protection is a common need for proprietary software algorithms and data protection. TrustZone
technology provides good hardware isolation for IP protection. TrustZone technology creates separation
between two regions: Secure (“trusted”) and Non-secure (“non-trusted”) code/data. Users who create
building blocks for others to integrate can take advantages of the TrustZone technology feature by storing
their software IP in the Secure (“trusted”) region.

Business Model

Not all software developers create end products. Some create building blocks, such as algorithms, for others
to integrate into an end product. One difficulty they face is the protection of their software IP. Their end
customers would prefer to receive source code, but source code can easily be copied and redistributed.
Even binary libraries are not complete protection, as there are tools that can disassemble binaries to
assembly and even C source code.

TrustZone® technology enables new business models for these developers in which they can program their
algorithms into the secure region of a TrustZone-enabled MCU and sell a value-added MCU, with their IP
protected by TrustZone and the Device Lifecycle Management (DLM) system of the RA MCU.

RA MCU Device Lifecycle Management Feature for IP Protection

During development, DLM state regression allows erasing the protected areas of flash (unless permanently
locked). This prevents reading of the protected area of the flash and hence protects the IP and eliminates
scrappage of devices in case the algorithms need to be modified.
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In production, if the algorithm developer would like to retain the potential to debug algorithms with the
application in place, they can install DLM keys for the NSECSD to SSD and DPL to NSECSD transitions.
Refer to the Renesas RA Family Installing and Utilizing the Device Lifecycle Management Keys application
note for the definition of the device lifecycle states and state regression operational flow.

e SSD: Secure Software Development
¢ NSECSD: Non-secure Software Development

e DPL: DePLoyed
RA MCU Flash Block Locking Feature for IP Protection

RA MCUs support temporary and permanent Flash Block Protections. This allows customer IP and Root of
Trust to be protected from accidental erasure and alteration.

IP Protection Development, Production and Deployment Flow

Develop Y  Program " Protect Deliver

Sell pre-programmed

Program algorithms
i devices

o ihe Bovice % Protect the algorithms

Create algorithms

Algorithm Developer

| % :
Program the % : >
A\ Create application ».  application into the ¥ Protect the application Sel]!ut?ieymei_s ‘“;'.th the
i ] : device application
) ) ’

Application Developers

Figure 4. IP Protection using Arm®TrustZone®

Designing for IP protection uses the Split Project Development model. See section 4.2 for the operational
details.
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1.4.2 Root of Trust Protection

The Root of Trust (RoT) is a product’s security foundation. All higher-level security is built on top of the RoT.
The RoT also implements recovery features for higher-level security breaches. When Root of Trust is
breached, recovery is not possible and can lead to serious consequences. For IoT applications, Root of Trust
may encapsulate authenticated firmware updates and secure internet communication.

To reduce the attack surface, the functionality included in the RoT should be as little as possible. Typical
services in the RoT are described in Figure 5.

» Factory keys -
« Device identity Root of Trust

) Firmware Verification
* Checksum/hash calculation on start-up

Firmware Update
Services

* Image verification
« Flash reprogramming P Flash and RAM
] Peripherals

« Crypto services
* Timer services

« Key/certificate and sensitive data storage
» Secure world stack

« None

Figure 5. Root of Trust Protection — Put as Little as Possible in the Secure Region

All other application code and device drivers should be considered to be allocated to the Non-secure region.

2. Arm® TrustZone® Application Design Support

This chapter introduces several IDE features that are established to simplify software development when
using the TrustZone hardware isolation with support from other MCU hardware components, FSP software,
or tooling.

2.1 Renesas Advanced Smart Configurator
The Renesas Advanced Smart Configurator (RASC) implements a project generator which allows TrustZone
and Non-TrustZone template projects to be conveniently generated.

2.1.1 Using RASC with Renesas e? studio
RASC is natively integrated with Renesas e? studio IDE.

Section 4 explains how to use the Smart Configurator to start TrustZone development.

2.1.2 Using RASC with IAR Embedded Workbench for Arm

Create the initial secure project using RASC and choose IAR Compiler. This process will generate the initial
secure project for AR EWARM. Once the initial IAR EWARM project is generated, user can open this project
from the IAR EWARM IDE.

Next, user should follow the rasc_quick _start.html file which is installed under \<RASC
installation root>\eclipse\. Referto rasc_quick_start._html section Adding tools to a third-
party IDE to integrate RASC as well as the Smart Bundle Viewer and the Renesas Device Partition Manager
into the IAR EWARM IDE.

Once RASC is integrated in IAR EWARM, you can open RASC within the IAR EWARM IDE to further
develop the TrustZone based secure and non-secure project application project following the operations
explained in section 4.
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2.1.3 Using RASC with Arm Keil MDK

The operation of using RASC, the Smart Bundle Viewer as well as the Device Partition Manager with Arm
Keil MDK to create TrustZone based application is identical to the development process for using RASC with
IAR EWARM in terms of the general flow. Note that the Smart Bundle Viewer is needed when using
TrustZone with Keil MDK. Section 5.6.2 demonstrated the usage of RASC, the Smart Bundle Viewer as well
the Renesas Device Partition Manager (RDPM).

2.2 Transitioning from CM State to SSD State

There are some prerequisites prior to setting up the MCU IDAU regions. From the factory, RA MCUs are
delivered to the developer in CM (Chip Manufacturing) lifecycle state. The MCU must be transitioned to SSD
(Secure Software Development) lifecycle state prior to setting up the IDAU regions.

Transitioning from CM State to SSD State and setting up the IDAU region can only be achieved using the
MCU’s boot mode, which can only be accessed using an SCI/USB connection. To benefit from the tools
support, developers need to bring the MCU Mode pin (MD) and SCI pins to the Debug interface. Special
debugger firmware has been developed to manage bringing the device up in SCI boot mode to set up the
IDAU registers (automatically drives MD pin) and then switch back to debug mode as needed.

Hardware design must reference the EK-RA6M4 debug interface design (signals in red) to provide proper
connections to support the above functionality.

Pin No. SWD JTAG Serial Programming using
SCI
1 VCC VCC VCC
2 P10&8/SWDIO P108/TMS NC
4 P300/SWCLK P300/TCK P201/MD
Wired OR with MD Wired OR with MD
6 P109/SWO/TXD9 P109/TDO/TXDO P109/TXD9
P110/RXD9 P110/TDI/RXD9 P110/RXD9
9 GNDdetect GNDdetect GNDdetect
10 nRESET nRESET nRESET

Figure 6. Debug Connection to Support TrustZone® Design
The operational flow when using this feature differs between e? studio and the EWARM IDE.

2.2.1 Developing with e? studio

When developing with e? studio and using Renesas evaluation kits for TrustZone MCUs, the MCU is
automatically transitioned from the CM state to the SSD state when the first secure program is downloaded
to the MCU if the above required connection is provided.

2.2.2 Developing with IAR EWARM

When developing with IAR EWARM, transitioning from CM to SSD needs to be performed manually using
Renesas Device Partition Manager or Renesas Flash Programmer. This is achieved by using the Initialize
device back to factory default option as shown in Figure 7.

2.2.3 Developing with Keil MDK

When developing with Keil MDK, transitioning from CM to SSD needs to be performed manually using
Renesas Device Partition Manager or Renesas Flash Programmer. This is achieved by using the Initialize
device back to factory default option as shown in Figure 7.

R11ANO467EU0160 Rev.1.60 Page 12 of 67
Apr.17.24 RENESAS



Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

2.3 Setting up the IDAU Region

Whether you are using €2 studio or a third-party IDE like Keil MDK or IAR EWARM, you can manually set up
the IDAU region using RDPM. As shown in Figure 7, the functionalities of the RDPM are under the Action
area. To set up the IDAU region, select Set TrustZone® secure / non-secure boundaries and provide the
IDAU region sizes in the IDAU region configuration area.

&) Renesas Device Partition Manager O X

€3 At least one action must be selected

Device Family: RenesasRA

Action
Functionality of /"E Read current device information [[]Change debug state

RDPM

[] Set TrustZone secure / non-secure boundaries [ Initialize device back to factory default
=S

Target MCU connection: J-Link ~
Connection Type: SCl ~

Emulator Connection: Serial No ~

Serial No/IP Address: [ ]

Debugger supply voltage (V):
Connection Speed (bps for SCI, Hz for SWD): 9600

Debug state to change to: Non-secure Software Development

Memeory partition sizes

Used when working — :
with IAR EWARM |_——P I|:|Use Renesas Partition Data file I

Browse...

Code Flash Secure (KB)

Code Flash N5C (KB
IDAU region e (K&l
configuration Data Flash Secure (KB)

SRAM Secure (KB)

SRAM NSC (KE) 6

Command line tool:

Browse...

':?3' Import Export Run Close

Figure 7. Functionality of RDPM

The RDPM also provides the following functionalities:
e Use Read current device information to read out the DLM and IDAU region setup information.
e Use Change device lifecycle management state to transition to a different state.

e Use Initialize device back to factory default to transition the DLM state to SSD if the device is in
NSECSD or DPL state.

When using e? studio, the IDAU region configuration is automatically loaded in the dialog box and there are
no additional actions needed to fill in the configuration data.

Pay special attention to the check box for Use Renesas Partition Data file. This check box is used when
setting up the IDAU region using IAR EWARM. You must use the generated . rpd fie to configure the IDAU
region. This usage is described in section 5.5. Once an . rpd file is selected, the new IADU region
configuration information will be updated automatically based on the . rpd file.

Note: The .rpd filename is stored for future runs. When switching to another project, you must reselect
the . rpd file.

The operational flow for using the RDPM differs between e? studio, EWARM IDE and Keil MDK, as detailed
in the following sections.

R11ANO467EU0160 Rev.1.60 Page 13 of 67
Apr.17.24 RENESAS




Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

2.3.1 Developing with e? studio

When using e? studio, the necessary values to set up the TrustZone® memory partition (IDAU registers) are
calculated after the binary code to program into the Secure region is created by building the Secure project.
The regions are set up to ensure that they match the code and data sizes and keep the attack surface as
small as possible. If the hardware connection mentioned in Figure 6 is provided in the PCB design, there is
no need to use the RDPM manually to set up the IDAU region. Setting up the IDAU region when developing
with e? studio is a transparent process for most applications.

2.3.2 Developing with IAR EWARM

Unlike e? studio, setting up the IDAU when developing with IAR EWARM needs to be performed semi-
manually using the RDPM. As part of the debug configuration generated when the RASC creates a project
for EWARM, there is the invocation of a C-SPY macro file called partition_device.mac as shown in
Figure 8.

Categary: Factary Settings
General Options
Static Analysis E
Runtime Checking
C/C++ Compiler Setup  Download Images Mullicore  Extra Options  Plugins =
Assembler o
Output Converter Driver Runto
Custom Buid Jink /- Trace v E
Build Actions
Linker Setup macros £

(B Debugger |Use macro file(s) ]
ImUlator

CADI |SPHOJ_DIHS'-part'rtion_device.mac | ]

CMSIS DAP | I
GDB Server
Ijet

E %{Isntt’;ia:;ace [ Ovenide defautt

Nu-Link STOOLKIT_DIR$\CONFIG'\debugger\Renesas\R7FAGMAAF d |-
PE micro

1] stam

t Third-Party Driver
TIMSP-FET
TIXDS

Device description file I

1 ar. Canicel

Figure 8. Debug Configuration for IDAU Region Setup

As part of the debug startup sequence, this file will invoke the RDPM integrated to check the target MCU’s
TrustZone partition boundaries and compare them against the settings calculated as part of the project build
sequence. If a mismatch is found, a dialog is displayed asking you whether to reconfigure the IDAU region.
You can then choose to launch the RDPM and set up the IDAU regions.

"e:' Target device needs TrustZone partition sizes to be changed before debug session can be started.

Launch the Renesas Device Partition Manager tool?

Yes No

Figure 9. Prompt to Launch the Renesas Device Partition Manager
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2.3.3 Developing with Keil MDK

Unlike e? studio, setting up the IDAU when developing with Keil MDK needs to be performed manually using
the RDPM. The walk through of setting up the IDAU region when working with Keil MDK is demonstrated in
section 5.6.1.

3. General Considerations in TrustZone® Application Design

3.1 Non-secure Callable Modules

Some driver and middleware stacks in the Secure project may need to be accessed by the Non-secure
partition. To enable generation of NSC veneers, set Non-secure Callable from the right-click context menu
for the selected modules in the Configurator.

Note: Itis only possible to configure top of stacks as NSC.

& g_uartl UART Driver on r_sci_uart
@ Team »
T - T Rescurce Configurations >
% Add DTC Driver for % Add DTC Driver for v|  Validate
Transmission Reception [Mot o Cut Chrle X
[Recommended but recommended] i Y r
optional] [[E Copy Ctrl+C
Paste Ctrl+V
Delete Delete ) g_uartd UART Driver
i_uart
Mon-secure Callable ?1}? onrselua
Import... @
rn_ Fxnart... ¥

Figure 10. Generate NSC Veneers

3.2 Guard Function for Non-secure Callables

Access to NSC drivers from a Non-secure project is possible through the Guard APls. The FSP automatically
generates guard functions for all the top of stack/driver APIs configured in the Secure project as Non-secure
Callable.

Some best practices and guidelines for using the guard functions are listed as follows:

3.2.1 Limit Access to Selected Configurations and Controls

The default guard functions generated ignore p_ctrl and p_cfg arguments sent in from NS side. Instead,
the guard function provides static Secure region instances of these data structures based on the module
Instance.

BSP_CMSE_NONSECURE_ENTRY fsp_err_t g_uart0O_open_guard(
uart_ctrl_t *const p_api_ctrl, uart cfg_t const *const p _cfg) {
/* TODO: add your own security checks here */

FSP_PARAMETER_NOT_USED(p_api_ctrl);
FSP_PARAMETER_NOT_USED(p_cfg);

return R_SCI_UART_Open(&g_uartO_ctrl, &g_uartO_cfg);

Figure 11. Example Guard Function
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3.2.2 Test for Non-secure Buffer Locations

o If the Non-secure region is providing input (such as by calling the write () function with data buffer),
then the guard functions should check that data buffer is entirely within an NS area.

o If the Non-secure region is providing a pointer to store output (such as by calling the read () function with
a pointer of where to store), then the guard functions should check that the data buffer is entirely within a
NS area.

See section 3.5.1 for examples of using the CMSE library to handle this requirement.

3.2.3 Handle Non-secure Data Input Structure as Volatile

If a Non-secure region is providing a data structure as input (for example, a typedef~d structure with 3
members), then guard functions should make a copy of the data structure in the Secure region before
passing to the Secure function. This is done because Non-secure data structure should be seen as volatile,
and the Non-secure region could alter contents after invoking the NSC function.

See section 3.5.2 for an example of how to handle this requirement.

3.2.4 Limit the Number of Arguments in an NSC Function

The compiler uses registers RO to R3 to pass parameters and return values. Registers R4 to R12 are used
during function execution. The called function restores registers R4 to R12. Therefore, if an NSC API is being
used for a Secure function with more than 4 arguments, the guard function should define a function with a
different prototype that will be a funnel to handle all of the arguments. The new function prototype should
take a data structure that has members to cover all parameters in the Secure function. This means that Non-
secure code will need to put the function arguments into the structure. The guard function will then expand
the data structure into separate arguments and pass them to the Secure function.

Figure 12 shows an FSP example for funneling the 5 arguments from the R_SP1_WriteRead function to 4
arguments in the NSC API guard function.

/** Non-secure arguments for write-read guard function */
= typedef struct st_spi write_read guard_args

{
void const * p_src;
void * p_dest;
uint32_t const length;

spi bit width t const bit width;
j@lspi write read guard args tS

/* This function has been modified to reduce the number of arguments. */
2 BSP_CMSE_MNONSECURE_ENTRY fsp_err_t g spi@ write_read_guard fanin(spi_ctrl t *const p_api ctrl,
spi write read guard args t *args)
1

/* Verify all pointers are in non-secure memory. */

spi_write_read_guard_args_t *args_checked = cmse_check pointed_cbject (args, CMSE_AU_NONSECURE);

FSP_ASSERT (args == args_checked);

void const *p_src_checked = cmse_check_address_range ((void*) args_checked->p_src, args_checked->length,
CMSE_AU_NONSECURE) ;

FSP_ASSERT (args_checked-»p_src == p_src_checked);

void *p_dest_checked = cmse_check_address_range (args_checked-»>p_dest, args_checked->length, CMSE_AU NONSECURE);

FSP_ASSERT (args_checked-»p _dest == p_dest_checked);

: add your own security checks here */

FSP_PARAMETER_NOT_USED (p_api_ctrl);

I return R_SPI_WriteRead (&g_spi® ctrl, p_src_checked, p_dest_checked, args_checked->length, args_checked->bit_width); I

}

Figure 12. Handling Secure Functions with More than 4 Arguments
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3.3 Creating User-Defined Non-secure Callable Functions

For IP protection purposes, you can create a customized NSC API in the Secure project to expose only the
top-level control of your algorithms and store the IP in the Secure Arm® TrustZone® region. Precautions
mentioned previously should be exercised during the creation of the user-defined NSC API.

Steps to create a customized NSC API are:

1. Create the Non-secure Callable custom function by declaring the function with
BSP_CMSE_NONSECURE_ENTRY.

2. Create a header file that includes all the customized NSC function prototypes, for example,
my_nsc_api-h.

3. Include the path to the NSC header using the Build Variable as shown in Figure 13.

4. Compile the Secure project to create the Secure bundle. The NSC header will be automatically extracted
in the Non-secure project for use.

@ Properties for bare_metal_minimum_s O X
[ type filter text Build Variables v v 8
Resource
Builders
~ CfC++ Build Configuration: |Release [ Active ] | | Manage Configurations...
Build Variables
Environment
Legging
Settings Name Type Value Add...
Tool Chain Editor UserNscApiFiles File List "S{workspace_loc/bare_metal_minimum_s/src/my_nsc_apih}" Edit
C/C++ General
MCU Delete

Project Matures
Project References
Renesas OF
Run/Debug Settings
Task Tags

Validation

[ show system variables

Build Variables are IDE only variables, which can be used for string substitution when defining external builder configuration, such as envircnment
variable value or command line parameter in form of ${VAR}, internal builder may use them directly.

Restore Defaults Apply

.”'_?j. Apply and Close Cancel

Figure 13. Link User-Defined Non-secure Callable API Header File
3.4 RTOS Support

Renesas tooling and the FSP support Non-secure partition RTOS integration with Secure region access
through Non-secure callable APIs. Secure projects can use the Secure TrustZone Support — Minimum
project type to add the Arm TrustZone Context RA port. For operation details, see section 4.1.1, Step 3 for
Secure Project handling and section 4.1.2, Step 5 Non-secure Project Handling.

3.5 Writing TrustZone Technology Enabled Software

Security design using TrustZone technology has some specific challenges that secure developers should
bear in mind and take corresponding actions when writing the secure application software.

This section provides several guidelines that secure software developers should consider following in order
to avoid Secure information leak to the Non-secure region.

3.5.1 Benefitting from CMSE Functions to Enhance System Level Security

This subsection discusses how to benefit from the CMSE library to improve the secure software design.
Some examples of the CMSE functions are:

e cmse_check address_range: For example, this function can be used to confirm the address range is
entirely in the Non-secure region.

e cmse_check pointed object: For example, this function can be used to confirm the memory
pointed to by the pointer is entirely in the Non-secure region.

R11ANO467EU0160 Rev.1.60 Page 17 of 67
Apr.17.24 RENESAS



Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

BSP_CMSE_NONSECURE_ENTRY fsp_err_t g _uartO_read_guard(uart_ctrl_t *const p_api_ctrl,
uint8_t *const p_dest,
uint32_t const bytes)

/* Verify all pointers are in non-secure memory. */

uint8_t *const p_dest_checked = cmse_check _address_range ((void*) p_dest, bytes,
CMSE_AU_NONSECURE) ;

FSP_ASSERT (p_dest == p_dest_checked);

/* TODO: add your own security checks here */

FSP_PARAMETER_NOT_USED (p_api_ctrl);

return R_SCI_UART_Read (&g_uartO_ctrl, p_dest_checked, bytes);

Figure 14. Non-secure Buffer Address Range Check

3.5.2 Avoid Asynchronous Modifications to Currently Processed Data

An example of handling is shown in Figure 15. When the pointer p points to Non-secure memory, it is
possible for its value to change after the memory accesses used to perform the array bounds check, but
before the memory access is used to index the array. Such an asynchronous change to Non-secure memory
would render this array bounds check useless.

int array[N];
void foo(volatile int *p)

{
n P
if (i >=02&& i <N) { array[i] = 0; }

Figure 15. Treat Non-secure Data as Volatile in Secure Code
3.5.3 Utilize the Armv8-M Stack Pointer Stack Limit Feature
The Armv8-M architecture introduces stack limit registers that trigger an exception on a stack overflow.
CM23 with Arm® TrustZone® technology has two stack limit registers in the Secure state:
e Stack Limit Register for Main Stack: MSPLIM_S
e Stack Limit Register for Process Stack: PSPLIM_S

CM33 with TrustZone technology has two stack limit registers in the Secure state and two stack limit
registers in the Non-secure state:

e Stack Limit Register for Main Stack in Secure state: MSPLIM_S

e Stack Limit Register for Process Stack in Secure state: PSPLIM_S

e Stack Limit Register for Main Stack in Non-secure state: MSPLIM_NS

e Stack Limit Register for Process Stack in Non-secure state: PSPLIM_NS

Users can implement customized fault handlers to catch the stack limit overflow error.

Refer to Arm®v8-M Architecture Reference Manual section The Armv8-M Architecture Profile for more
information on the functionality of the stack limit registers.

4. Using Renesas RA Project Generator for TrustZone Development

The RASC is designed for TrustZone technology-based applications. It provides ease of use based on the
following implementation features from the tools and FSP point of view:

¢ RA Project Generator guides you through the TrustZone project creation process.

e TrustZone IDAU region setup during Secure program download, calculated automatically based on the
Secure project. See section 2.1 for more details.

e The FSP provides a quick and versatile way to build secure connected I0oT devices using Renesas RA
MCUs.

Note: FSP version information is removed from the following screen captures because these instructions
apply to all FSP versions 5.0.0 or later.
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RA Project Generator

The RA Project Generator provides three project types to create the initial template projects for developing
with Arm® TrustZone® technology enabled MCUs:

e A Secure Project and Non-secure Project Type pair which work with the Secure and Non-secure
partitions respectively.

e A Flat Project with which an application can be developed with no TrustZone partition awareness.

e Whether developing with a TrustZone enabled project or with a Flat project, the MCU needs to transit
from the CM state to the SSD state prior to proceeding with the development.

&) Renesas RA C/C++ Project O ped

Renesas RA C/C++ Project —
Project Type Selection

Project Type Selection

(®) Flat (Non-TrustZone) Project
* Renesas RA device project without TrustZone separation
® All code, data and peripheral settings will be configured in
this project
* Renesas RA device will remain in secure mode
* EDMAC RAM buffers will autematically be placed in non-
——cerure BAk]

() TrustZone Secure Project

* Renesas RA device project for TrustZone secure execution

® All code, data and peripherals placed in this project will be
initialized as secure

® Secure project settings such as TrustZone partitions, linker
rmaps and a list of secure peripherals will be passed to a
selected non-secure project

® Afterinitialization, a call to the non-secure startup handler
will be made

() TrustZone Non-secure Project

* Renesas RA device project for TrustZone non-secure
execution

® All code, data and peripherals placed in this project will be
initialized as nen-secure

® Must be associated with a secure project or secure bundle

* Non-secure startup handler will be called after secure code
initialization

@ < Back Next > Finish Cancel

Figure 16. RA Project Generator
For RA TrustZone technology enabled MCUs, there are two development models:

e Combined Project Development
— Secure and Non-secure applications are developed by one trusted team.
e Split Project Development
— Secure and Non-secure applications are developed by two different teams.
— The Non-secure application team does not have direct access to Secure partition assets. Access to
Secure partition is only possible via Non-secure Callable APIs.

The design process based on each of these two development models are introduced in the subsequent
subsections. The design process based on the Flat Project type is introduced in section 4.3.
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4.1 Combined Project Development

With the Combined Project Development Model, Secure and Non-secure projects are developed by a single
trusted team. A Secure project must reside in the same workspace as the Non-secure project and is typically
used when a design engineer has access to both the Secure and Non-secure project sources.

In addition, a Secure .elf file is referenced and included in the debug configuration for Debug build for

download to the target device. The development engineer has visibility of Secure and Non-secure project
source code and configuration.

4.1.1 Developing the Secure Project

Most peripherals and 10 defined in the Secure project are configured as Secure with the exceptions of Clock,
QSPI, OSPI, and the CS Area. These peripherals can be used in the Secure project and be configured as
Non-secure.

The major IDE operational steps in developing the Secure project are explained in the following steps.
Step 1: Create a new project using the RA Project Generator template.
Renesas RA MCU tooling provides several project templates to help kickstart development.

Figure 17 to Figure 21 show some common steps when creating a new project with e? studio regardless of
whether Secure or Non-secure projects are to be created with either the Split Project Development Model or
Combined Project Development Model.

e This step will be referenced in the context of Non-secure Project Development for the Combined Project
Development Model.

e This step will be referenced in context of Secure and Non-secure Project Development for the Split
Project Development Model.

I Q new_ws - http://tool-support.renesas.com/autoupdate/support/smartbrowser/en-us/ToolNews/e2s/index.html - & studio
! Edit Source Refactor MNavigate Search Project RenesasViews Run Window Help

i Alt+Shift«N > [T Makefile Project with Existing Code
v Open File... [c] C/C++ Project
H ~ - - =5 -
J L Open Projects from File System... ™ Project.. Create anew C or C++ project
Recent files ? [e] Convertto a C/C++ Project (Adds C/C++ Nature)
Close Editor Ctrl+W &Y Source Folder
Close All Editors Ctrl+Shift+W % Folder
Figure 17. Create New Project
&) New C/C++ Project O Pt
Templates for New C/C++ Project
an ] Empty or Existing CMake Project ~
CMake Creats @ CMake project with no files. Can be 1
Make used to create one over existing content.
Renesas Debug
Renesas RA @#=~ Makefile Project
Wy, (Experimental) Create a new project that
builds with the'make’ build tool using COTs n
Renesas Debug Only Project
Fm\ Renesos Debug Only Project
Renesas RA C/C++ Project
FE=mp Create an executable or static library C/C++
project for Renesas RA.
W
< >
'i?;' < Back Mext = Finish Cancel
Figure 18. Select “Renesas RA C/C++ Project”
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Click Finish, then provide the Secure project name. It is helpful to attach “_s” (for Secure”) and “_ns” (for
Non-secure) to the end of the project name as a reminder of the security nature of this project.

ﬁ Renesas RA C/C++ Project

Renesas RA C/C++ Project

Project Name and Location

Project name

I bare_metal_minimum_5| I

Use default location
CAIOTSG-28538\new_wshbare_metal_minimum_s

default

You can download more Renesas packs here

@ < Back Mext > Finish

== 0 = =" o = =T Y B

Browse...

Cancel

e = OGO

Figure 19. Define the Name of the Secure Project
Click Next, then select the EK-RA6M4 BSP.

Evaluation kit for RAGM4 MCU Group
Evauk L “| Visit www.renesas.com/ra/ek-rabmd4 to get kit user's manual, quick
| Device: Customn User Board (Any Device) start guide, errata, design package, example projects, etc.
' EK-RA2A1
EK-RA4M1
Language:  |pe paawd
EK-RABM1
EK-RAGM2 Device Details
EK-RAGM3
TrustZone Yes
[ —— T
Processor cortex-m33

Figure 20. Select the BSP

Note: By default, the BSP functionality with regards to security control is only enabled in the Secure project.

Once the BSP is selected, click Next to view the summary for the hardware setup page.

Version number based on elstudio
version

< Back

Cancel

EVAILATION KIL TOF FADHS MLU UIoup ~

Board: | EK-RAGM4 I s s, renesas.com/ra/ek-rabmd to get kit user's

: TEABMAA start guide, errata, design package, example

Device: RTFAEMAAFICFB projects. stc. b

Core: 33 Device Details

Language @C OC++ TrustZone Yes A

Pins 144
| Processor Cortex-M33 bl

Toclchains Debugger

GNU ARM Embedded J-Link ARM

Figure 21. Review the Configurations Prior to Proceeding to Next Step
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Click Next and proceed to the following steps.

Note: Step 2 to Step 7 below are common for the Split Project Development Model and Combined Project
Development Model. These steps are referred to in context of the Secure Project development for the
Split Project Development Model.

Step 2: Choose the TrustZone Secure Project as the Project Type.

Choose TrutZone Secure Project as the project type and take a moment to read the description on this
project type. All peripherals initialized in this project will be assumed to have the Secure attribute with the
exceptions indicated in Table 3 as Always Non-secure. All code and data placed in this project will be
initialized as Secure by the FSP BSP and control will be passed to Non-secure project reset handler at the
end of the Secure project execution.

{8} Renesas RA C/C++ Project O s

Renesas RA C/C++ Project —,
Project Type Selection

Project Type Selection

O Flat (Non-TrustZone) Project
* Renesas RA device project without TrustZone separation
* All code, data and peripheral settings will be configured in
this project
Renesas RA device will remain in secure mode
* EDMAC RAM buffers will automatically be placed in non-
secure RAM

l@ TrustZone Secure Project I
Enesas evice project tor TrustZone secure execution =

® All code, data and peripherals placed in this project will be
initialized as secure

* Secure project settings such as TrustZone partitions, linker
maps and a list of secure peripherals will be passed to a
selected non-secure project

* After initialization, a call to the non-secure startup handler
will be made

-

() TrustZone Non-secure Project
* Renesas RA device project for TrustZone non-secure execution
* All code, data and peripherals placed in this project will be
initialized as non-secure
® Must be associated with a secure project or secure bundle
* Mon-secure startup handler will be called after secure code
initialization

|:?>| < Back Mext = Finish Cancel

Figure 22. Choose the Secure Project Type
Click Next and choose the Project Template.
Step 3: Choose the project template.

As shown in Figure 23, there are two Secure project templates. You can choose which template to use
based on whether an RTOS is used in the Non-secure project.

e Bare Metal — Minimal
Secure project with MCU Initialization function with support on transitioning to Non-secure partition. This
application note uses the Bare Metal — Minimal project template as an example to explain the general
steps creating a secure project.
e TrustZone Secure RTOS — Minimal
— Secure projects will add the required RTOS context in the Secure region for the Thread that needs to
access the NSC APIs in an RTOS enabled project. When this project type is selected, the Arm
TrustZone Context RA Port will be added as shown in Figure 24.
— The RTOS kernel and user tasks will reside in the Non-secure patrtition.
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Q Renesas RA C/C++ Project i X

Renesas RA C/C++ Project —<
Project Template Selection

Project Template Selection

®

" Bare Metal - Minimal

<,

O

o,

Code Generation Settings
Use Renesas Code Formatter

Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

" TrustZone Secure - Minimal project with support for Non-secure RTOS |

Empty TrustZone Secure project with Non-secure callable RTOS context functions that will allow threads in a

Non-secure application to call Secure services. This is not support for using an RTOS in a Secure project. Without these
RTOS context functions, there could be issues if a context switch occurs while a thread in the Non-secure application is
executing a Secure service. This will support any RTOS as long as the RTOS uses the CMSIS TrustZone Context

Management API. This project will initialize the MCU using the BSP. W

‘\?,‘ < Back Next > Cancel
Figure 23. Choose the Project Template
BB Renesas RA C/Ce+ Project m]

Renesas RA C/C+ + Project
Project Template Selection

Project Template Sefection

* Bare Metal - Minimal

Bare metal F5P

project that includes B5P. This propect will initislice clocks, piny, stacks, and the € runtime ervironment.

I-é-' db :I‘rustZunl

Secure - Minimal project with support for Non-secure RTOS I
.

Men-secure ap)

phation to call Secure servces. This it net suppart for using an RIS in a Secure project, Without these

RIS cortext functions, there could be maues i & content samch occurs while & thread in the Nen-tecuse apphcation i
executing & Secure senvice. This will support any RIS &3 long as the RIS uses the CMSIS TrustZone Context HAL/Common Stacks
Management AP1. This project wil initialize the MCU using the B59. Ll

Code Genera ;
[ Use Renesas Code Formatter

49 g_ioport I/O Port 42 ARM TrustZone
' Driver on r_icport Context RA Port
- @ @®
Mest + Fanish Cancel

Figure 24. Adding the TrustZone Context RA Port

Click Finish to allow the Project Generator to populate the project template.

Notes on Clock Control

The clock is initialized in the Secure project to allow faster start up. By default, the FSP sets all the security
attributes of the Clock Generation Circuit (CGC) to be Non-secure as shown in Figure 25. Therefore, both
Secure and Non-secure projects can change the clock setting.

Users have the option to set all the security attributes of CGC as Secure, thus the Non-secure project

developer can

not override the secure project setting as shown in Figure 26.
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IR )

-

= Clock Src: PLL ~ == [CLK Div /1
[ PCLKA Div /2
[= PCLKE Div /4

[ PCLKC Div /4

[ PCLED Diwv /2

[ BCLK Diw /2

iR A Qi -

-

WMDY DS R L P Fl e

= B ] Package £ MCU Packad

G =

: 1Y
Generate Project Content

Ed L4 |

5] Secure E3 Restore Defaults

g ‘|:| |C|—KF—ODM! Sete the clock circuit to be secure (override disabled)

~ —={ PCLKA 100MHz |

~ —>| PCLKE 50MHz | R —
« —s{ PCLKC 50MHz |
« > PCLKD 100MHz |

—
v —={ BCLK 100MHz | .“E

Details on the Lock Icon

(5) Secure q (i) Secure

Not Locked Locke

Figure 25. Secure Project Sets Clock as Secure

——= [CLK Diwv /1

[~ PICLEA Div /2

M PCLEB Div /4

M PCLEC Div /4

M PCLED Div /2

> BCLE Diwv /2

o

Generate Project Content

I "B Owerride B Restore Defaults
—| ICLK 200MHz | -
—>| PCLKA 100MHz |
—>{ PCLKB 50MHz |
—>] PCLKC 50MHz |

—>| PCLKD 100MHz |

—)| BCLK 100MHz |

Figure 26. Non-secure Project Clock control “Override and Restore Default” Disabled

Step 4: Generate Project Content and compile the project template.

Double click configuration.xml to open
Figure 27.

the configurator. Click Generate Project Content as shown in

I Project Explorer 53

&

2 8

8

==

vﬁ bare_metal_minimal_s

|Z| bare_metal_minimal_s Debug.launch
{54 configuration xml

. Objects
[E| R7FABM4AF3CFE.pincfg

W] Rernone

= B & [bare_metal_minimal_s] FSP Configuration &2

Stacks Configuration

[l Includes

= ra 4] Mew Thread
Threads

(£ ra_gen 3] Remaove

2 src

= ra_cfg v & HAL/Common

(= script <

i) Mew Object »

=

]

(V]

Generate Project Content

HAL/Common Stacks ) New Stack > £ Extend Stack > 3] Rernove

=)

49 g_ioport 1/0 Port
Driver on r_ioport

®

<>

{7) Developer Assistance

Summary|E‘~SP|Clocks|Pins|Interrupts|E\.rentLinks Stacks Components|

Figure 27. Generate Project Content
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Right-click on the project and select Build Project.

:w new_ws - bare_metal_minimal_s/configuration.xml - &* studio
File Edit Mavigate Search Project RenesacViews Run Window Help
& | | 17 (| ™ ¥ Debug ~ | | [E7] bare_metal_minimal_s Debug - = W R o~ By
{5 Praoject Explorer &3 | 13_{- [bare_metal_minimal_s] FSP Configuration 3
- = 11 g
~ |5 bare_metal_minimal_s [Del New >
nit Includes Go Into
D ra HAL/Common Stacks & New Sta
s B ra_gen Open in New Window
3 src Show In Alt+Shift+W > 4% g_ioport /O Port
(= Debu: - Driver on r_icport
=5 o [E Copy CtrlsC =op
= ra_cfg -
(= seript Paste Chrl+V 6]
! bare_metal_minimal_s D« 3§ Delete Delete
8} configuration.xmi Snurce >
71 RTFAGMAAFICFE.pincfg e
> (7) Developer Assistance -
(&) Pevelopss ! Rename... F2 Event Links | Stacks | Components
[C] Properties 52 [%] Problems | gug Import.
bare_metal_minimal_s £} Export;
g Expaort FSP Project...
Resource Property ("] Export FSP User Pack...
~ Infa
dariead Build Project | Incremental Build of Selected Projects
editable Clean Project
last modified | Refresh F5 5 2020, 10:59:13 AM
linked .
Close Project
lecation 2 158\ new_ws\bare_metal_minimal_s
haE Cloze Unralated Project bninimal £

Figure 28. Compile the Template Project

Note: By default, the GPIO driver to control the Secure GPIO pins is included in the template. You can
remove the GPIO driver, if is not needed, to reduce the project footprint.

Figure 29 is an example of the compilation result based on Bare-Metal Minimum project template.

CDT Build Console [bare_metal_minimum_s]

........ R e e L e e e T e

Building file: ../ra/board/raém4_ek/board_leds.c 1
Building target: bare_metal_minimum_s.elf
arm-none-eabi-objcopy -0 srec "bare_metal_minimum_s.elf" “bare_metal_minimum_s.srec”
arm-none-eabi-size --format=berkeley "bare_metal_minimum_s.elf"

text data bss dec hex filename

Figure 29. Compilation Result of the Bare-Metal Minimum Secure Template Project
Step 5: Review the initial Secure bundle generated.

After successful compilation, the Secure bundle <project_name>.sbd is generated as shown in Figure
30.

5 Praoject Explorer 33 BE Y % = O
w % bare_metal_minimal_s [Debug]
q-;-? Binaries
[a Includes
= ra
2 ra_gen
[ src
w (= Debug
= ra
= ra_gen
= src
:)t& bare_metal_minimal_s.elf - [arm/le]
secure.o - [arm/le]
= bare_metal_minimal_s.elf.in
bare metal minimal s.ma
bare_metal_minimal_s.sbd

bare_metal_minimal_s.srec
| @ makefile

= makefileinit

| & objects.mk

| @ sources.mk
o ra fn

Figure 30. Secure Bundle Generated
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Step 6: Develop the Secure application.

During the product development, it is likely that you will go through the following steps iteratively prior to
completing development:

e Add Needed FSP Modules:

— Define NSC Modules if needed. See Section 3.1 for details.

— Note: Ethernet cannot be used in the Secure Project. It is only available in the Non-secure Project.
e Create user-defined Non-secure Callable Functions if needed. See section 3.3 for details.
e Develop the Secure applications:

— Design the code flow such that the Secure applications that are not Non-secure Callable are
executed prior to starting the Non-secure project execution: prior to function call
R_BSP_NonSecureEnter();

e Recompile and test the application.

Step 7: Debug the Secure project in isolation.

With the Combined Project Development Model, the Secure project is typically not debugged in isolation
from the Non-secure project. To debug a Secure project on its own, you can use the following options:

e Prepare a “dummy/test” Non-secure project. This approach offers the benefits of allowing the Non-secure
Callable APIs to be debugged in the test Non-secure project.

e Replace R_BSP_NonSecureEnter(); withwhile(1); in hal_entry.c and debug the Secure
project by itself. Be sure to restore the R_BSP_NonSecureEnter () ; after debugging the Secure project
prior to provisioning the Secure project to the MCU.

Step 8: Debug the Secure project with the Non-secure project.

For the Combined Project Development Model, Secure and Non-secure project development can be
debugged in one workspace. Debugging the Secure project typically does not happen in an isolated manner
for the Combined Project Development Model. See Section 4.1.2, Step 7 for operational details.

4.1.2 Developing the Non-secure Project

Once the Secure template project is established and compiled, you can start the Non-secure template
project creation in the same workspace where the Secure project resides.

Step 1: Follow Step 1in section 4.1.1 to start a new Non-secure project.

It is helpful to attach “_ns” to the end of the project name as a reminder of the security configuration of this
project.

Step 2: Choose Non-secure project as the Project Type.

Renesas RA C/C++ Project —
Project Type Selection

Project Type Selection

O Flat (NonT ustZone) Project
s RA device project without TrustZene separation
. Alc da,dt nd peripheral settings il e onfigured in
this projec
. RenesasRAdevi:ewMIramaininsecuramude
. EDMAC RAM buffers will automatically be placed in non-
e RAM

(@] TrustZone Secure Project
Renesas RA device project for TrustZon:
o Al :oda data and peripherals placed in this proJe:tw\II be
mmanzad as secure
Sec ect s

ustZo prtt s, linker
p ph rots will e e pa o

e proj
* After lmt\allzatmn a caH to the nen-secure startup handler
will be made
—

@® Tn stlone Non-secur

. RA devi

. Au Code, data
initialized as non-secure

* Must be associated with a secure et bundle

Mo cure trtph ndler will be called after ode

nitializatio

@ < Back Finish T

Figure 31. Choose Non-secure Project as Project Type
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Step 3: Establish linkage to the Secure project which resides in the same e? studio workspace.

Click the down arrow and select the secure project bare_metal_minimum_s created in section 4.1.1.

Note: The Secure project must exist in the same workspace AND be open for it to be referenced in the
selection box. The Secure project must also be built to create the information used to set up the Non-

secure project.

Q Renesas RA C/C++ Project

Renesas RA C/C++ Project

Existing Secure Project or Bundle Selection

I (®) Secure Project: | bare_metal_minimal_s

() Secure Bundle:

Choose this option if you have access to the TrustZone Secure Project source code. A debug configuration for Secure
Software Debug (550) state will be generated and both secure and non-secure images will be downloaded to the target

device, Should you wish to test Non-5ecure Software Debug (NSECSD) state, use the Renesas Device Partition Manager to
change the Device Lifecycle state as needed.

Browse...

Secure Project/Bundle Details

F5P version 200

Toolchain gec-arm-embedded

Toolchain version 6.2.1.20191025

Board board.rabmdek

Device R7FABMAAF3CFE
@ <Bock || Net> Finish Cancel

=g

Figure 32. Establish Linkage to the Secure Project

Click Next to proceed.

Step 4: Follow the prompt as shown below to choose whether the Non-secure project will have RTOS

support.

ﬂ Renesas RA C/C+ + Project
Renesas RA C/C++ Project

Build Artifact and RTOS Selection

Build Artifact Selection
(@) Executable

* Project builds to an executable file

RTOS Selection

Azure RTOS ThreadX
FreeRTOS

(version)
version)

Cancel

Figure 33. Choose Whether to Use FreeRTOS in the Non-secure Project

Click Next to proceed.
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Step 5: Select the project template to finish creating the Non-secure template project.

o If FreeRTOS is selected, the Project Generator provides the following two project templates. Choose the
project template based on the application needs. An example for FreeRTOS is shown as follows. Azure
RTOS has similar options.

{8} Renesas RA C/C++ Project O X

Renesas RA C/C++ Project —

Project Template Selection

Project Template Selection

@ (—} FreeRTOS - Blinky - Static Allocation
- FreeRTOS FSP project that includes BSP and will blink LEDs if available. FreeRTOS is pre-configured for static memory
allocation. This project will initialize the MCU using the BSP. FreeRTOS will also be initialized and a single thread to blink the
LEDs will be started.

I ® g " FreeRTOS - Minimal - Static Allocation I
£

Empty FreeRTOS FSP project with no threads. FreeRTOS is pre-configured for static memeory allocation. This project will
initialize the MCU using the BSP.

Code Generation Settings
Use Renesas Code Formatter

'i?;' < Back Mext » Cancel

Figure 34. Template Options for FreeRTOS Enabled Projects

Note: If FreeRTOS is selected and there is access to NSC functions from a Thread in the Non-secure
project, it is necessary to enable Allocate secure context for this thread in the configurator for

that Thread.
~ Thread
Symbol new_thread0
Name New Thread
Stack size (bytes) 1024
Priority 1
Thread Context NULL
ion Static
Allocate Secure Context Enable

Figure 35. Enable Secure Context Allocation

e If No RTOS is selected, the Project Generator provides the following two project templates.
Note: The No RTOS selection must be selected if a new RTOS other than FreeRTOS is to be
integrated in the Non-secure project.
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Q Renesas RA C/C++ Project
Renesas RA C/C++ Project
Project Template Selection
Project Template Selection

O (_-} Bare Metal - Blinky

Bare metal FSP project that includes BSP and will blink LEDs if available. This project will initialize clocks, pins, stacks, and

the C runtime environment.

I ® sy  Bare Metal - Minimal I

w* . Bare metal FSP project that includes BSP. This project will initialize clocks, pins, stacks, and the C runtime environment.

Code Generation Settings
Use Renesas Code Formatter

Cancel

Figure 36. Template Options for Non-FreeRTOS usage

e Click Finish to create the corresponding template project.
Even though there are security properties allowed for configuration in the BSP Properties page,
they are not being enabled with the current IDE support. The following attributes cannot be

Note:

configured from the Non-secure project:

Summmary | BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components
|#] Problems @ Smart Browser [C] Properties &3

EK-RAGM4

Settings Property
> R7FAGMAAF3CFB
RAGNM4
~ RAGM4 Family
w Security
Exceptions
SRAM Accessibility
BUS Accessibility
Systemn Reset Request Accessibility
System Reset Status Accessibility
Battery Backup Accessibility
OFS0 register settings
Independent WDT
WDT
OFS51 register settings
Voltage Detection O Circuit Start
Voltage Detection 0 Level
HOCO OScillation Enable
w Block Protection Settings (BPS)
BRSO
BP51
BP52
Permanent Block Protection Settings (PEPS)
PBPS0
PBPS1
PBPS2
Dual Bank Mode

<

<

<

Value

Secure State
Both Secure and Mon-Secure State
Both Secure and Mon-Secure State

Voltage monitor O reset is disabled after reset
2.80V
HOCO oscillation is disabled after reset

Disabled

Figure 37. Attributes That Are Not Configurable from a Non-secure Project
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e By default, the Non-secure project BSP can reconfigure the MCU clock. Refer to Notes on Clock Control.

Step 6: Follow Instructions from Step 1, Section 4.1.1 to Generate Project Content and compile the
Non-secure project.

Notice that both the Secure project bare_metal_minimun_s and bare_metal_minimum_ns reside in
the same workspace.

Q new_ws - bare_metal_minimurn_ns/configurationxml - & studio - ] >

File Edit Mavigate Search Project RenesasViews Run  Window Help

7{;& Debug [£7] bare_metal_minimurmn_ns Debug S 5 - | B o 5& v |ms &| 7%& - Cﬁ -

WiF e - L == v| [ Q i | HE C/C++ {54 FSP Configuration
[§5 Project Explorer 537 = O i:"-“..} [bare_metal_minimum_s] FSP Confi... 5:0:3 [bare_metal_minimum_ns] FSP Con... &% = 0 | gP. M. =2 = O

BT 3
557 8 Stacks Configuration 0o

vl < bare_metal_minirnum_nsl Generate Project Content n - = 3 1>
3%, Binaries = z z

[t Includes &7 Mew Stack >
Threads HAL/Common Stacks
2 ra B

2 ra_gen

3 src w &% HAL/Common

(= Debug 4% g_ioport I/0 Port D
= ra_cfg

= script a S @
bare_metal_minimum_ns Debug_S550.1a

42 g_ioport I/0 Port
Driver on r_ioport

& configurationaml
=l RTFABMAAFICFE.pincfg Objects

=% bare_metal_minimum_s

< >  Summary |BSP | Clocks | Pins | Interrupts | Event Links | Stacks | Components » Legend
[ Properties 2 [2] Problems @ Smart Browser = B  [E4 PinConflicts [ Console &% LT <§>| =l mE .Ex| B~y = 8
% & Y g CID'II' Build Console [bare_metal_minimum_ns]
A
Property Value 'Building target: bare_metal_minimum_ns.elf’

'Invoking: GNU ARM Cross C Linker'
arm-none-eabi-gcc @ bare_metal minimum_ns.elf.in™
'Finished building target: bare_metal minimum ns.elf’

"Invoking: GNU ARM Cross Create Flash Image’
'Invoking: GNU ARM Cross Print Size'
arm-none-eabi-cbjcopy -0 srec "bare_metal minimum_ns.elf” “bare_metal minimum_ns.
arm-none-eabi-size --format=berkeley "bare_metal_minimum_ns.elf"
tavt Aat= hes Aar hav Filanama

Figure 38. Compile the Non-secure Project (No RTOS, Bare-Metal Minimum)
Step 7: Debug both the Secure and Non-secure projects.

As shown in Figure 39, the debug configuration of the Non-secure project programs both the Secure and
Non-secure _elT files to the MCU by default to allow a unified debug session of both the Secure and Non-
secure projects.

Notice that <project_name> <build_configuration>_SSD.launch is generated, as debugging both
Secure and Non-secure projects are performed in device lifecycle state SSD.
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ﬁ Debug Cenfigurations m} X

Create, manage, and run configurations

i Iiil> o E X | El l? M Name: | bare_metal_minimum_ns Debug_S50
|t',-'pefi|tertext | Main | %% Debugger | = Startup . [C] Common T‘é/ Source
[T] C/C++ Application Initialization Commands ~
E C/C++ Remote Application []Reset and Delay (seconds): 3
=/ EASE Script
[€] GDB Hardware Debugging L1 Halt

[£] GDB OpenOCD Debugging

[E7] GDB Simulater Debugging (RHE50)
[ Java Applet

[T Java Application

1 Launch Group Load image and symbols
= Launch Group (Deprecated)

—hilsname Load type Add..
bare_metal_minimurm_s.elf [C\OTSG-2858\new_ws\bare_metal_minimum_s\Debug] | Image and Symbol
Program Binary [bare_metal_minimum_ns.elf] Image and Symbol Edit...
Remove
v
Revert Apply

Filter matched 15 of 17 items
@ Close

= E=T = T

Figure 39. Debug Both the Secure and Non-secure Projects

Note: The Secure project must be built each time it is changed to ensure that the connection to the Non-
Secure project is maintained. When the Secure bundle changes, there will be a popup window asking
you to take the latest Secure bundle. Click Yes, then recompile the Non-secure project so that the
updated <project_name>.sbd will be used.

g [bare_metal_minimal_ns] FSP Configuration e

The secure bundle file 'bare_metal_minimal_s.sbd’ has changed, do you want to
" restart this editor?

Figure 40. Secure Bundle Update Notification
Tips on Ensuring Synchronization between Secure and Non-secure Project

To avoid accidental updates from the Secure Project being missed, you can also define the Secure project
as a reference to the Non-secure project so that compiling the Non-secure project will automatically trigger a
compilation to the Secure project.

Open the Properties page of the Non-secure project, click Project References and choose the
corresponding Secure project as the Reference project. Once this is set up, compiling the Non-secure project
will always trigger the Secure project to be recompiled.

Q Properties for bare_metal_minimal_ns O >

| | Project References - ~ 8
Re.source & Projects may refer to other projects in the workspace. ~
Builders Use this page to specify what other projects are referenced by the project.
C/C++ Build
C/C++ General Project references for 'bare_metal_minimal_ns"
C. " _ I =% bare_metal_minimal_s I
Renesas U
Run/Debug Settings ha v

@ Tromy enaciosg] | cCancel
Figure 41. Create Project Reference
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4.1.3 Production Flow Overview

This step is for production flow; it is not a step needed during development. Once both Secure and Non-
secure project development is finished, you can send the following information to the production line for the
MCU to be provisioned prior to selling:

e Secure binary
e Non-secure binary
e |IDAU region configuration

Refer to section 6.2 to program the Secure binary and section 6.3 to program the Non-secure binary and
transition the MCU state to one of the following device lifecycle states:

o DPL (DePLoyed): The debug interface is disabled temporarily. The serial programming interface is
available but cannot access the code and data flash.

e | CK_DBG (LoCKed DeBuG): The debug interface is permanently disabled. The serial programming
interface is available but cannot access the code and data flash.

e LCK_BOOT (LoCKed BOOT interface): The debug interface and the serial programming interface are
permanently disabled.

4.2 Split Project Development
Characteristics of the Split Project Development Model include:

e The Secure project and Non-secure project are developed separately by two different teams.

e The Secure project will be developed first by the IP provider. The IP provider creates a Secure bundle.

e The Secure bundle is pre-programmed on the device prior to the Non-secure developer starting their
development. Only the Non-secure project and Non-secure partition are visible to the Non-secure
developer.

4.2.1 Developing the Secure Bundle and Provisioning the MCU

Developing the Secure project using the Split Project Development Model is very similar to the Combined
Project Development Model. However, several key differences are explained in this section.

Step 1: Follow Step 1to Step 6 from section 4.1.1 to establish the Secure template project and create
the applications.

Debugging the Secure project with the Split Project Development Model will not happen with the Non-secure
project for the product. As explained in Step 7, section 4.1.1, you can create a dummy Non-secure project for
the purpose of Secure project testing, for example to test the Non-secure callable APIs.

Step 2: Provision the MCU with the Secure project and change the device lifecycle state to NSECSD.

A major difference between Split Project Development and Combined Project Development is that the
Secure binary associated with the Secure bundle needs to be provisioned to the MCU prior to the Non-
secure project development for the Split Project Development. The Secure bundle contains the Secure
project IP in binary format and the NSC API interface from Secure project. In addition, the MCU device
lifecycle state needs to transition from SSD to NSECSD to protect the Secure content.
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4.2.2 Limitations and Workarounds for Developing in NSECSD State

There is a limitation with the current version of the tools in that a dummy Non-secure project must be
provisioned on the device in addition to the Secure binary prior to changing the MCU device lifecycle from
SSD to NSECSD with the Split Project Development Model. This is necessary to allow the Non-secure
development to resume in the NSEDSD state.

¢ Inthe development stage, follow the Combined Project Development Model to prepare a dummy Non-
secure project paired with the intended Secure project. Program the Secure binary and the dummy Non-
secure binary first and then change the device lifecycle state to NSECSD.

¢ Inthe production stage, send the following items to the production team:
— Secure binary
— IDAU region setup information
RFP will be used to program the Secure binary and set up the IDAU region. See section 6.2 for the
operational details.

¢ Note that the Secure developer also needs to provide the Secure bundle (<project_name>_sbd) to
the Non-secure developer to allow Non-secure project to proceed to development.

e See Figure 42 for details on the general flow to support Non-secure project development in the NSECSD
state.

4.2.3 Developing the Non-secure Project in NSECSD State

Developing a Non-secure project using the Split Project Development Model has some key differences
compared with the Combined Project Development Model.

For the Split Project Development Model, the Non-secure application developer receives the MCU in the
NSECSD state. As mentioned towards the end of last section, special handling is needed to enable
development in the NSECSD state. Figure 42 is a summary of the general flow for developing in the
NSECSD state.

Develop and test Program Secure ch Lifecyl Pass provisioned
Secure application and TEST* Non- ange Litecyle device and Secure

7 ; state (DLM) to -
with TEST Non Secure code into NSECSD bundle file (*.shd) to

Secure project device MNon-Secure developer

Start new Non-Secure
project and select Debug using NSECSD
Secure bundle file debug configuration
(*.sbd)

Figure 42. Development Flow for Developing in NSECSD State

Once the Non-secure developers receive the MCU provisioned with the Secure binary, IDAU region, and the
Non-secure dummy binary in the NSECSD state, they can use the following steps to proceed to the Non-
secure project development:

1. Follow step 1 and step 2 in section 4.1.2 to start Non-secure project development.
Typically, the Non-secure project will be created in a different workspace from the Secure project as the
Secure project source file and - el T file will not be available for the Non-secure developer.
2. When the Secure Bundle Selection window opens, choose the secure bundle obtained from the Secure
developer.
This step is a key difference between Combined Project Development and Split Project Development
process.
The Secure Bundle contains the following information to allow Non-secure project development:
— MCU startup code
— IDAU region setup
— Details of locked Secure peripherals configuration settings
— User-defined Non-secure Callable API interface header file (refer to section 3.3)
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& Renesas RA C/C++ Project O X
Renesas RA C/C++ Project —
Existing Secure Project or Bundle Selection

() Secure Project:

p Secure Bundle: | C:\OT5G-2858\new_ws\bare_metal_minimal_s\Debug\bare_metal_minimal_s.sbd | IBrowse...I

Choose this option if you only have access to a pre-programmed device containing TrustZone secure code, The Secure
Bundle file (*.sbd) should be ebtained from the TrustZone Secure Project developer. A debug configuration for Non-Secure
Software Debug (MSECSD) state will be generated and only the non-secure code image will be downloaded to the target
device.,

Secure Project/Bundle Details

FSP version
Toolchain

Teelchain version

Beard board.rabmdek
Device RYFABMAAFICFB
@ < Back Next > Frsit Tored

Figure 43. Create Linkage to Secure Bundle

Note: The Secure Bundle is linked in with an absolute path. Verify the Secure Bundle linkage whenever the

folder location of the <project _name>.sbd changes.

Follow the prompts to define RTOS usage and select the template project. Once the project is generated,
double click configuration.xml to open the smart configurator. Click Generate Project Content and
compile the project.

Q new_ws - bare_metal_minimum_ns/src/hal_entry.c - & studio - O *

File Edit Source Refactor Navigate Search Project RenesasViews Run  Window Help

R[] [8] 0w

5 Project Explorer 53

v 1% bare_metal_minimum_ns

5 Binaries

[ Includes

= ra

2 ra_gen

3 src

= Debug

(= ra_cfg

E bare_metal_minimurm_ns Debug_

-

I B-/-&

Rt~ Q-

WL 2 ~

R =

= B  {i [bare_metal_minimum_ns] FSP Configuration

Q ® | M c/cer {4 FSP Configuration
hal_entry.c &2 =8 *» B8
#include "hal data.h” A

BES Y 3

FSP_CPP_HEADER
wvoid R_BSP_WarmStart(bsp_warm_start_event_t event); =
FSP_CPP_FOOTER

@ * main() is generated by the RA Configuration editer and is )
—woid hal entry(void) {

/* : add your own code here */
= #if BSP_TZ_SECURE_BUILD

/* Enter nen-secure code */

L script
|=| bare_metal_minimum_ns Debug NSECSD.Jaunch I

R T N e Y T

R_BSP_NonSecureEnter();

text data bss

dec hex filename

507 configuration.xml #endif
[Z] RTFABMAAF3CFE.pincfg 7 }
- L]

(® Developer Assistance <} @ * This function is called at various peints during the start ¥
< > < >
BHP 2 = O [ PinConflicts B Console 2 i g <==,:‘>| CE BE _-Ex| # B =0

e &  CDT Build Console [bare_metal_minimum_ns]
Y Erm-nonE-Edul-UD JLUPY U SCEC  Dale_iie Lo L_inLr Cuin_iis. e 11 D E_ine La L_InLr Linuin_i1% . S ec ~

Property V arm-none-eabi-size --format=berkeley “bare_metal_minimum_ns.elf"

Figure 44. Compilation Result of Non RTOS Bare-Metal Minimum Non-secure Project Template

Notice that <project_name> <build_configuration>_ NSECSD. launch is generated as the
development is carried out in the NSECSD state.
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4.2.3.1 Debug the Non-secure Project

Prior to debugging the Non-secure project, ensure that the Secure binary as well as the dummy Non-secure
binary are programmed on the MCU.

During Non-secure project debugging, only the Non-secure . el T file will be downloaded. There is only the
Non-secure project visible in the workspace for the Non-secure developer as opposed to both Secure and
Non-secure projects being visible with the Combined Project Development.

@ new_ws - bare_metal_minimum_ns/src/hal_entry.c - & studio

File Edit Source Refactor Navigate Search Project RenesasViews Run Window Help

LYIENNC S

+ || Me Launch Cenfigurations | om [ — . m ® -

£5 Project Explorer 51 =

£1 g [bare_metal_minimum _ns] £SP Canfi
v 125 bare_metal minimum_ns [Debug] 1
<

New

Go Into

#include "hal |

FSP_CPP_HEADE

Open in New Window void R_BSP_Wa

Show In
B Copy

K Delete

mumn_ns Debug_NSECSD jlink Source

= -pinely Rename. -
(@ Developer Assistance
Import...
3 EBxport..
fsg  Export FSP Project...
%] Export FSP User Pack...

Build Project
Clean Project
Refresh

Close Project

Build Targets
p Index
Build Configurations

[T] Properties &2 [2] Problems @ Smart Bro...

Fun As
% DebugAs
Property Team

~ Info Compare With
derived Restore from Local Historv..,

bare_metal_minimum_ns

Resource

Alt+Shift=W >
Chrl=C

Delete

FSP_CPP_FODTE

main() is
void hal_entr

=

< #if BSP_TZ_SE
* Enter

R_BSP_Nons

#endif
}

This functd

= void R_BSP_Wa
if (85P_w
= #if BSP_FEATU
En.
R_FAC
C
Hendif

if (BSP_i

1 GDE Simulater Debugging (RH50)

-
> E 3 Renesas GDE Hardware Debugging I
* v

v (=% bare_metal_minimum_ns [Debug]
3% Binaries

) Includes

B ra

2 ra_gen

2 src

(= Debug

= ra_cfg

(= script

= bare_metal_minimum_ns Debug_NSECSD.launch

10 configuration.xml
[Z] R7FABM4AF3CFB.pincfg
(7) Developer Assistance

Figure 45. Debug the Non-secure Project
Notes on updating the Secure Bundle:

e If during Non-secure project development, the Secure Bundle needs to be updated, the Non-secure
Developer would need to return the MCU to the Secure Development team for MCU update.

e See section Non-secure Debug in the document ESP User’'s Manual section: Primer: Arm® TrustZone®
Project Development section Non-secure Debug to understand how the tools handle protection of the
Secure region when debugging the Non-secure project in the NSECSD Device Lifecycle State.

4.2.3.2 Program the Non-secure Project and Transition to DPL Device Lifecycle State
This step is for the production flow. It is not normally needed during Non-secure project development.

Once the Non-secure project is fully debugged, the Non-secure binary can be sent to the production line to
program the MCU and transition to the DPL device lifecycle state. Refer to section 6.3 for operational details.

See the application note, Installing and Utilizing the Device Lifecycle Management Keys (R11AN0469) for
information about other possible deployment mechanisms (LCK_DBG, LCK_BOOT) as well as the state
regression methods utilizing the DLM key through an authenticated procedure.

4.2.4 Production Flow Overview

Refer to section 6 to understand the example production flow. For the Split Project Development Model,
there can be multiple vendors involved in the production flow:

e Secure image handling vendor: the production team programs the Secure image, sets up the IDAU
boundary, injects the desired DLM and User Keys, and transitions the MCU to the NSECSD state. The
production team also needs to provide the .sbd bundle to the Non-secure application production team.

e Non-secure image handling vendor: the production team programs the Non-secure image and transitions
the MCU to a deployment device lifecycle. See section 4.1.3 for the different possible states.
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4.3 Flat Project Development

The Flat Project type in the RA Project Generator refers to the development model in which the developer
does not need to develop the application with TrustZone® technology awareness:

e One single project handles the entire application.

e Development flow is identical to the Non-TrustZone technology part.

e The MCU operates in the SSD device lifecycle state.

o All peripherals that support Secure and Non-secure attributes will operate in Secure mode.
e Peripherals as identified as Non-secure only in Table 3 will operate in Non-secure mode.

4.3.1 Operational Flow

1. Follow Step 1 and Step 2 from section 4.2.1 to start creating the Flat Project template project.

2. Select Flat Project as the project type from the Project Generator.

3. Choose the Build Artifact Selection and RTOS Selection (same interface as in Figure 33).

4. The rest of the development is the same as the development for a Non-TrustZone technology enabled
MCUs and is out of scope of this application project.

5. Debug Flat Project.

Debugging the Flat Project follows the Non-TrustZone RA MCU Debugging model. The launch file
named: <program_name> <build_configuration>_Flat.launch.

&5 Project Explorer £3 = B & [flat_project] FSP Configuration \.] startup.c lg] main.c 3
= S v 3 '* generated main source file - do not edit */

5 it project Dot dinclude "haldaca.h

3, Binaries

[ry Includes hal_entry ();

= ra return @;

2 ra_gen b

2 src

== Debug

(= ra_cfg

[= script

{5 configurationxml
=|_flat project Debug Flatjlink

T R/TABTIaA E.pinc
5 De’veloperAssista:ce g |#] Problems B Console 52 @ Smart Browser
CDT Build Console [flat_project]
Extracting support files...
15:18:83 **** Incremental Build of configuration Debug for project flat_project **%*
make -j8 all
"Invoking: GNU ARM Cross Print Size'
arm-none-eabi-size --format=berkeley "flat_project.elf™
text data bss dec hex filename

Figure 46. Debug the Flat Project

4.3.2 Ethernet Application

In the case of using Ethernet with a Flat Project, the IDE will calculate the size of the SRAM buffer on an 8KB
boundary based on the application to cover all the Ethernet buffer usage. The IDE will then allocate this
region to Non-secure SRAM region in the .rdp file. This entire process is automatically handled by the IDE
and FSP, the operation is transparent to users.

4.3.3 Production Flow Overview

Production of the Flat Project development model will bring in TrustZone technology awareness. The Flat
Project development is carried out in the MCU lifecycle state SSD. For production deployment, you have the
same options as the TrustZone technology aware development model: Split Project Development Model or
Combined Project Development Model.

e Option one is to transition the MCU lifecycle state from SSD to NSECSD, then transition to DPL.
— If desired, the MCU lifecycle state can then be transitioned further to LCK_DBG or LCK_BOOT.
e Option two is to transition the MCU state from SSD directly to LCK_DBG or LCK_BOOT.

Refer to section 4.1.3 for the different possible states.

R11ANO467EU0160 Rev.1.60 Page 36 of 67
Apr.17.24 RENESAS




Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

5. Example Project for IP Protection

As discussed in section 1.4.1, IP Protection is a strong use case for TrustZone® technology. The project
accompanying this document utilizes the Split Project Development Model to provide an IP protection
example TrustZone use case with EK-RA6M4 using the e? studio IDE. The Combined Project Development
Model is used for the IAR EWARM and Keil MDK projects.

5.1 Overview

RA6M4 MCUs can be configured to use an ADC peripheral to monitor the on-chip temperature sensor. This
application project defines an algorithm to control the LED blinking pattern based on the temperature read
from the ADC. The following hardware components are configured as Secure by the Secure project:

e ADC channel for on-chip temperature sensor reading.
e GPIO 400, 404, and 415.
e Secure flash and SRAM setup by the IDAU.

The following software components are configured as Secure by the Secure project:

e The FSP ADC HAL driver.
e The FSP GPIO HAL driver for the corresponding LED driving pins.
e The application code that starts, scans, and stops the ADC.
e The application code that controls the LED blinking pattern based on the temperature reading.
e The API that starts the monitoring and reacting algorithm.
— This API is defined as Non-secure Callable APl and its veneer is exposed to the Non-secure
partition.
e The API that stops the monitoring and reacting algorithm.
— This API is defined as Non-secure Callable API and its veneer is exposed to the Non-secure

partition.
Code Flash

GPIO
ADC Customized Application
and NSC API

IP Algorithm Veneer
API

Figure 47. Sensor Algorithm IP Protection
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5.2 System Architecture

5.2.1 Software Components
Figure 48 shows the Secure, Non-secure, and Non-secure Callable hardware and software partition scheme
in this example project.

Color Legend

Non-secure
Callable Partition

Non-Secure

Partition

Secure Partition

NSC APl Veneer

Figure 48. Software Architecture Block Diagram
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5.2.2 Operational Flow
Figure 49 shows the system-level operational flow of the example project.

Start

l

Transition to
Mon-secure

World

l

=zer menu selection
received? b

MEC AP

sensor algorit
bm start guard
Veneer

Color Legend

MNon-secure
Callable Partiion
MEC AP

Senszor_algorit
hm_stop_guard
Veneer

MNon-5ecure

Partition

Run Secure Partition
Senzor_algorit
hrn_stop_guard

Figure 49. Operational Flow
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5.2.3 Simulated User’s IP Algorithm
The simulated user’s IP algorithm is described in Figure 50.

Note: In Figure 50, TSN means on-chip Temperature Sensor.

> B
_
<>

Figure 50. Simulated Sensor IP Algorithms (Running in Secure Partition)

5.2.4 User-Defined Non-secure Callable APIs

The Non-secure callable functions exposed to the Non-secure partition are defined in
sensor_algorithm _nsc.h from the Secure project.

®| * File Name : sensor_algorithm_nsc.h[]
@® * DISCLAIMER[]
= #ifndef SENSOR_ALGORITHM NSC_H_

#define SENSOR_ALGORITHM_NSC_H_

#include <hal_data.h>

BSP_CMSE_NONSECURE_ENTRY wvoid sensor_algorithm_start_guard{void);
BSP_CMSE_NONSECURE_ENTRY woid sensor_algorithm_stop_guard(void);

#endif /* SENSOR_ALGORITHM_NSC_H_ */

Figure 51. User-Defined NSC APIs
To share the user-defined NSC calls, this header file is linked to e? studio by a Build Variable.
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The path to this header file is added using the Build Variable UserNscApiFi les as shown in Figure 52.

@ Properties for pre_programmed_sensor_algorithm_s m} x
[ type filter text Build Variables v
Resource
Builders
~ CfC++ Build Configuration: |Debug [ Active ] ~ | | Manage Configurations...

Build Variables
Environment

Logging
Settings Mame Type Value Add...
Tool Chain Editor UserNscApiFiles  File List "Sfworkspace_loc/pre_programmed_senser_algorithm_s/src/sensor_algorithm_nsc.h}" Edit...
C/C++ General
MCU Delete

Project Matures
Project References
Renesas GE
Run/Debug Settings

Task Tags
Validation
[]Show system variables
Build Variables are IDE enly variables, which can be used for string substituticn when defining external builder configuration, such as environment variable value
or command line parameter in form of ${VAR}, internal builder may use them directly.
Restore Defaults Apply

|/'_7) Apply and Close Cancel

Figure 52. User Build Variable to Link User NSC Header File (Secure Project Setting) in e? studio

The Build Variable approach does not exist when using IAR EWARM and Keil MDK; you need to manually
share this header file with the Non-secure project. This is demonstrated in the included IAR EWARM and
Keil MDK example project.

5.3 Setting up Hardware

e Jumper setting — default EK-RA6M4 setting.
— See EK-RA6M4 User’s Manual.

e Connect J10 using USB macro to B cable from EK-RA6M4 to the development PC to provide power and
debugging capability using the on-board debugger.

Initialize the MCU

This step is optional but recommended. Prior to downloading the example application, it is recommended to
initialize the device to the SSD state. Unlocked flash content will be erased during this process. This step can
be achieved using the Renesas Device Partition Manager or RFP. This is particularly helpful if the device
was previously used in the NSECSD state or has a certain flash block locked up temporarily.

For instructions on how to use RFP to perform this function, see section 6.1.
Use Renesas Device Partition Manager and J-Link Debugger to initialize the MCU.

Establish the following connection prior to using the Renesas Device Partition Manager and the Onboard J-
Link debugger to perform Initialize device back to factory default. Note that Initialize device back to
factory default performs the same functionality as Initialize Device when using RFP:

e EK-RA6M4 jumper setting: J6 closed, J9 open. Other jumpers keep out-of-box setting.
e USB cable connected between J10 and development PC.

Note: You must power cycle the board prior to working with the Renesas Device Partition Manager after a
debug session if using J-Link as connection interface.

R11ANO467EU0160 Rev.1.60 Page 41 of 67
Apr.17.24 RENESAS




Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

Open Renesas Device Partition Manager

s  Run Window Help
red Renesas Device Partition Manager ﬂ [vl_
>

e b Tracex

e

Figure 53. Open the Renesas Device Partition Manager

Next, check Initialize device back to factory default, choose the connection method, then click Run.

&) Renesas Device Partition Manager O X
b
~
f| Device Family: RenesasRA
M Action
i Read current device information Change debug state
Set TrustZone secure / non-secure bcunclarir::l Initialize device back to factory default I
I Target MCU connection: J-Link ~
Connection Type: SCl ~
Emulator Connection: Serial N ~
Serial No/IP Address: [ ]
Debugger supply voltage (V): 0
Connection Speed (bps for SCI, Hz for SWD): | 9600
Debug state to change to: Secure Software Development
Memory partition sizes
[] Use Renesas Partition Data file
Browse...
Code Flash Secure (KB) 5
Code Flash NSC (KB) 27
Data Flash Secure (KB) 1]
SRAM Secure (KB) 2
SRAM NSC (KB) 6
Command line tool:
Browse...
v
@ Impert Export | Run | Close

Figure 54. Initialize RA6M4 using Renesas Device Partition Manager

After the MCU is initialized, proceed to the project importing and verification based on the IDE selected.
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5.4 Example Application with e? studio IDE using Split Project Development Model

The e? studio project utilizes the Split Project Development Model to establish an application for IP
protection. The assumption is that the Secure and Non-secure applications are developed by separate
teams.

5.4.1 Import, Build, and Program the Secure Binary and Dummy Non-secure Binary
Use the following steps to provision the MCU with the Secure binary and a dummy Non-secure binary.

5.4.1.1 Import the Secure Project and Dummy Non-secure Project

Unzip e2studio.zip, which is included in this application project, to reveal the folders shown in Figure 55.

non_secure_project

secure_project_and_dummy_ns_project
T pre_programmed_sensor_algorithm_dummy _ns

pre_programmed_sensor_algorithm_s

Figure 55. e2studio Software Project Content

Next, follow FSP User’'s Manual section, Importing an Existing Project into e2 studio to import the Secure
project and the dummy Non-secure project into the same workspace.

e Ly At B T inT e s § e

| ﬁ Import O it
Import Projects -
Select a directory to search for existing Eclipse projects, .-_’ ‘,
(®) Select root Gfta TR nlication_projectship_protection_tz\secure project_and_dummy_non_secure proje Browse...
() Select archive file: Browse...
Projects:
p_protection_tzhsecure_project_and_dummy_non_secure_project\pre_programmed_sensor_algorithm_dummy_ns) Select All
on_t\secure_project_and_durmmy_non_secure_project\pre_programmed_sensor_algorithrm_s)
Deselect All
Options
[J5earch for nested projects
] Copy projects into workspace
[] Close newly imported projects upon completion
[ Hide projects that already exist in the workspace
Working sets
(] Add project to working sets Mew..,
Select...

@' = Back Mext > | Finish Cancel

Figure 56. Import the Secure Project and Dummy Non-secure Project

Click Finish.
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5.4.1.2 Compile the Secure Binary and Dummy Non-secure Binary using e? studio

e Compile the Secure project first. Double click to open the configuration.xml in the Secure project.
Click Generation Project Content. Compile the Secure project. Ensure
pre_programmed_sensor_algorithm_s.srec and
pre_programmed_sensor_algorithm_s.sbd are generated.

e Next, compile the Dummy Non-secure project. Double click to open the configuration.xml in the
Dummy Non-secure project. Click Generate Project Content. Compile the Non-secure project. Ensure
pre_programmed_sensor_algorithm_dummy_ns.srec is generated.

5.4.1.3 Download the Secure Binary and Dummy Non-secure Binary using e2 studio
Prior to downloading and running the example project, user should first follow section 5.3 to set up the MCU.

Right-click on the pre_programmed_sensor_algorithm_dummy_ ns project and select Debug As >
Renesas GDB Hardware Debug. Click Resume twice to run the Secure and dummy Non-secure project.
Click Pause and confirm the execution pauses at the whi le(true) loop in the hal_entry() function in
hal_entry.c of the dummy Non-secure project.

- void hal_entry(void)
1
A : add vour own code here */
- #it BSE T2 SECURE BUILD
/* Enter non-secure code */
R_BSP_NonSecureEnter();
#endif
I

Figure 57. Program and Run the Secure and Dummy Non-secure Projects

Stop the debug session.
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5.4.1.4 Transition MCU Device Lifecycle State to NSECSD

After both the Secure binary and dummy Non-secure binary are downloaded to the MCU, you can use the
Renesas Device Partition Manager (RDPM) to transition the MCU from the SSD device lifecycle state to
the NSECSD device lifecycle state.

First, power cycle the board. Next, launch RDPM and configure to transit to NSECSD.

ﬁ Renesas Device Partition Manager O

Device Family: |Renesas RA

Action
[ Read current device information I [] Change debug state I
[ Set TrustZone secure / non-secure boundaries [ Initialize device back to factory default

Target MCU connection: J-Link ~
Connection Type: SCl ~
Emulator Connection: Serial No ~
Serial No/IP Address: [ ]
Debugger supply voltage (V): 0

Connection Speed (bps for SCI, Hz for SWD): | 8600

Debug state to change to: Mon-secure Software Development

Memeory partition sizes

[JUse Renesas Partition Data file

Browse...

Code Flash Secure (KB) 5

Code Flash M5C (KB) 27

Data Flash Secure (KB) 0

SRAM Secure (KEB) 2

SRAM MNSC (KB) ]

Command line tool:

Browse...

I':?::- Import Export |m‘ Close

Figure 58. Transition from SSD to NSECSD using Renesas Device Partition Manager

Click Run and ensure the transition is successful.
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Connecting...
Loading library : SUCCESSFUL!
Establishing connection : SUCCESSFUL!

Checking the device's TrustZone type @ SUCCESSFUL!

COMNMNECTED.

Transiticning DLM state...

Current DLM state : Secure Software Development (S50

Target DLM state  : Non-secure Software Development (NSECSD)
SUCCESSFUL

Discennecting...
DISCOMNMECTED.

: SUCCESSFUL!
: SUCCESSFUL!

Connection
DLM transition

Figure 59. Result: Transition from SSD to NSECSD

Refer to section 6.1 and section 6.2 for the operational steps of downloading the Secure binary and setting

up the IDAU region using RFP during production stage.

5.4.2 Import, Build, and Program the Non-secure Project

Once the DLM transitions to NSECSD, you can proceed to download the real Non-secure project.

5.4.2.1 Import the Non-secure Project

Follow the ESP User’s Manual section, Importing an Existing Project into e2 studio to import the Non-secure
project into the workspace. You can import into the workspace where the Secure project is imported for the

purpose of verifying the example project.

ﬁ Import

Import Projects

Select a directory to search for existing Eclipse projects.

(®) Select root directory:

ons\application_projects\tz_ip_protection\e2studio\non-secure project N

() Select archive file:

Projects:

I pre_programmed_sensor_algorithm_ns(C:\IOTSG-ZSSE\repo_dE\r\ra_solutions\application_prj

Options

[[]5earch for nested projects

[[]Copy projects into workspace

[[] Close newly imported projects upon completion
[[]Hide projects that already exist in the workspace

Working sets

[[] Add project to working sets

< Back Mext =

[ ]

Browse...

Browse...

Select All

Deselect All

Select...

Cancel

Figure 60. Import the Non-secure Project
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Note: You must update the Build Variable SecureBundle by selecting the
pre_programmed_sensor_algorithm_s.sbd based on your local file structure, prior to moving
forward to the other steps. This is a limitation with the current tools.

a Properties for pre_programmed_sensor_algorithm_ns O X

Build Variables G

Resource
Builders

Build Variables

1 nviranmen
Logging

Settings Type Value Add...
Tool Chain Edit l SmartBundle [ile C\TrustZone_|AR_Keil\eZstudio\secure_project_and_dummy_ns_project\pre_programmed_sensor_algerithm_s\Debug\pre_programmed_sensor_algorithm_s.sbd

C/C++ General 3

MCU 2 " | Delete
Project Natures
Project Reference

v Configuration: |Debug [ Active ] ~ | | Manage Configurations...

Renesas QF

Run/Debug Settin

Task Tags

Validation
[ Show system variables
Build Variables are |DE only variables, which can be used for string substitution when defining external builder configuration, such as environment variable value or command line parameter in form of
S{VAR}, intemal builder may use them directly.

¢ 5 Restore Defaults Apply

@ Apply and Close Cancel

Type Value

File  C\TrustZone_|AR_Keil\e2studio\secure_project_and_dummy_ns_proj elt\pre_prog rammed_senser_algerithm_s\Debughpre_programmed_sensor_algorithm_s.sbd I

4.

h variables

builder may use them directly.

Restore Defaults

Debug [ Active] ~ | | Manage Configur

re IDE only variables, which can be used for string substitution when defining external builder configuration, such as environment variable value or command line parameter in

A

S. | Apply and Close Car

Figure 61. Referencing the Secure Bundle
5.4.2.2 Compile and Download the Non-secure Project

e Double click to open the configuration.xml in the Non-secure project. Click Generation Project
Content. Compile the Non-secure project.
e Download and run the Non-secure project.
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Q non-secure project - pre_programmed_sensor_algorithm_ns/src/sensor_algorithm_nsc.h - & studie
File Edit Source Refactor Mavigate Search Project RenesasViews Run  Window Help
45 Debug [&7 pre_programmed_sensor_algorithr g~ | [ A W RN SR e ) ‘ tr v Qi Oy v A Ol [
| It = <‘§|> 7y & = B {5 [pre_programmed_sensor_algorithm_ns] FSP Configuration startup.c [.€] main.c ]
v =5 pre_programmed_sensor_algorithm_ns [Debug] I T Mame : sensor_algorithm nsc.h[]
New > BIMER[]
naries
- Go Into SENSOR_ALGORITHM_NSC_H_
(e Includes SENSOR_ALGORTTHM_NSC_H_
g 2 Open in New Window
ra_gen
. o Show In Altshiftew > | <haldata-h>
SEGGER RTT \ | NONSECURE_ENTRY void sensor_algorithm_start_guard(void)
% definitions.h B Cory Cit=C  T\ONSECURE_ENTRY void sensor_algorithm stop_guard(void);
. app_defini |o.|ns".1 Paste Crl+V
commaon_utils, E CENSOR Al GO " By
& b enw—c % Delete Delete SENSOR_ALGORITHM_NSC_H_ */
m sensor_algorithm_nsc.h Source ?
= Debug Move...
(= racfg Rename... F2
(= script
5,‘6:3 configurationxml v |mport.
|Z pre_programmed_sensor_algorithm_ns Debug P .5 Export...
|=| pre_programmed_sensor_algorithm_ns Debug_I 5y Export FSP Project...
=] RTFABMAAF3CFB.pincfg & e D el
(7) Developer Assistance port serrack..
Build Project
Clean Project
Refresh F5
Close Project
Close Unrelated Project
Build Targets >
Index >
Build Configurations >
{3 FRunAs ¥
I’t@ Debug As > IE| 1 GDB Simulater Debugging (RHE50)
Profile As > 2 Local C/C++ Application
Team >|E| 3 Renesas GDE Hardware Debugging I
Compare With > [ 4 Renesas Simulator Debugging (RX, RL78)
Restore from Local History... Debug Configurations..
MISRA-C >
2Ny C/Ces Drniert Settinae Cirle 842D b Smart Browser

Figure 62. Download and Run the Non-secure Project

Note: For the Split Project Development model, the debug session of the Non-secure project created by
referencing the Secure Bundle rather than the Secure Project (as with the case for the dummy Non-
secure project) only downloads the _el T file of the Non-secure project.

5.4.3 Verify the Example Application

The projects are now loaded, and the debugger should be paused in the Reset_Handler () at the

SystemInit() call in the Non-secure project.

45 Debug 32 B | iv| e §
~ [ pre_programmed_sensor_algorithm_ns Debug_NSECSD [Renesas GD
e ﬁ pre_programmed_sensor_algorithm_ns.elf [1] [cores: 0]
~w g Thread #1 1 (single core) [core: 0] (Suspended : Signal : SIGTRE
= Reset Handler{) at startup.c:59 0x904c
po| arm-none-eabi-gdb (7.2.2)
b Renesas GDB server (Host)

= B {8 [pre_programmed_sensor_algorithm_ns] FSP Configuration 52 [g startup.c 52

@

void DeFauit_Handlt‘:r(vo:}.&);
int32_t main(woid);

* MCU starts executing here out of reset. Main

= void Reset_Handler (void)

/¥ Initialize system using BSP. */
SystemInit();

/* Call user application. */
main();

while (1)
i

/¥ Infinite Loop. */

Figure 63. Running the Non-secure Project

Open the J-Link RTT Viewer 7.92j or later. First, click “...” and select R7TFA6M4AF from Renesas as the
Target Device. Next, set the connection to J-Link to Existing Session and the RTT Control Block to
Search Range. Set the search range to 0x20000000 0x8000 and then click OK to start RTT Viewer.
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ﬂ J-Link RTT Viewer V7.92 | Configuration X
Connection to J-Link
() uss
) TCr/P
||© Existing Session I Auto Reconnect

[] use non-default port

Specify Target Device

|| R7FAGM4AF I

Force go on connect

Script file (optional)

Target Interface & Speed
SWD 4000 kHz

RTT Control Block
() Auto Detection () Address (@) Search Range

Enter one or more address range(s) the RTT Control block can be located in.
Syntax: <RangeStart [Hex]> <RangeSize=[, <RangelStart [Hex]> <RangelSize=, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

| ox20000000 0xs000 | |

[ ] cnee

Figure 64. Start the RTT Viewer

Next, click Lg twice to run the project.

The user menu is then output, and the system waits for user input.

File Terminalzs Input Logging Help

All Terminals Terminal 0 Terminal 1

Figure 65. User Menu
Input 1 to start the IP algorithm. You will see the green LED start to blink after a couple of seconds.

You can warm up the MCU (for example, touch the MCU using grouped fingers) and see that the green LED
stops blinking and the red LED starts to blink after about 5-10 seconds.

Start IP Algorithm

If temperature did not change more than thresheld, the Green LED will blink
If temperature changed more than threshold, the Red LED will blink

Figure 66. User Input ‘1’

Input 2 to stop the IP algorithm. The green or red LED stops blinking. The blue LED blinks twice and stops
blinking.
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@8> Stop_IP_Algorithm

@8> Blue LED will toggle twice
@8> Press 1 to restart the IP Algorithm

Figure 67. User Input ‘2’
You can repeatedly input 1 to restart the IP algorithm and input 2 to stop.
Notes on Running the Application in Standalone Mode

After the MCU is programmed with the application code, you can run the application in standalone mode
(with no debugging session). In this case, choose USB as the Connection to J-Link.

ﬂ J-Link RTT Viewer V7.92j | Configuration X

Connection to J-Link

M |:| Serial No
O TCriP

O Existing Session

Specify Target Device

| R7FA6M4AF v

|:| Force go on connect

Script file (optional)

Target Interface & Speed
SWD | 4000 kHz -

RTT Control Block

() Auto Detection () Address (@ Search Range

Enter one or more address range(s) the RTT Control block can be located in.
Syntax: <RangeStart [Hex]> <RangeSize>[, <RangelStart [Hex]> <RangelSize>, ...]
Example: 0x10000000 0x1000, 0x2000000 0x1000

I 020000000 0x8000 |

Cancel

Figure 68. SEGGER RTT Viewer Connection Setup when MCU Running in Standalone Mode

5.5 Example Application with IAR EWARM using Combined Development Model

The IAR based projects use the Combined Development model. The assumption is that the Secure and Non-
secure applications are developed by one team.

Unzip 1AR.zip to explore the IAR project contents.

N . sensor_algerithm_ns File folder
on-secure project <
sensor_algorithm_s File folder
Secure project < settings File folder
Workspace File  «———— e sensor_algerithm AR IDE Workspace
|| sensor_algorithm.custom_argvars CUSTOM_ARGVARS File

Figure 69. IAR EWARM Software Project Content

R11ANO467EU0160 Rev.1.60 Page 50 of 67
Apr.17.24 RENESAS




Renesas RA Family Security Design with Arm® TrustZone® - IP Protection

5.5.1 Import and Build the Example Projects
Use the following steps to build the IAR example project:

1. Double-click on \1AR\sensor_trustzone.eww to launch the IAR EWARM. There are two projects in
this workspace. Click on the Secure project \sensor_s to make it the active project.

2. Notice that the header file sensor_algorithm_nsc.h, which includes the user-defined NSC functions,
is included in both the Secure project and Non-secure project.

3. Select Tools > RA Smart Configurator.

@ sensor_trustzone - |AR Embedded Waorkbench IDE - Arm 9.40.2
File Edit View Project J-link | Tools | Window Help

Tj ﬂ ﬁ ﬂ E ;j |_'1 £+ Options... |

Workspace Filename Extensions...
Debug Configure Viewers...
Files Configure Custom Argument Variables...

=R ] SENSOr_S - Debug ‘& Configure Tools...
&2 W Flex Software

— K X . IAR Project Converter
B Build Configuration !

-_Components I RA Smart Configurator

i Generated Data -

L5 W Program Entry * _ INTRIN
hal_entry.c * _ INTRINSIC vo

sensor_algotithm_nsc.c
[ sensor_algorithm_nsc.h
L— B huildinfo.ipcf

Figure 70. Launch RA Smart Configurator from IAR

4. Once the RA Smart Configurator is launched, click Generate Project Content.

5. Close the RA Smart Configurator.

6. Return to the EWARM IDE, right-click on sensor_s and select Rebuild All. The Secure project will be
compiled.

7. Select the Non-secure project sensor_ns to make it the active project.

8. Select Tools > RA Smart Configurator.

9. Click Generate Project Content.

10. Return to the EWARM IDE and check if there is a \Objects folder under \Flex_Software and
secure .o exists in the \Objects folder. If yes, the non-secure project will be compiled with no issue. If
not, then the non-secure project will need to be compiled twice. The first compile will issue an error
message similar to Figure 72. The second compile process will succeed. This is because there is a
timing issue between EWARM and RSAC operation.

FE: ko
=) lsensor_ns-Debug ||
=1 B Flex Software

Bl Build Canfiquration

B Compaonents

B Generated Data

B Ohjects
| [ secure.o
I—|§| M Frogram Entry

Figure 71. Check that the secure.o is included in the project

SEIEUT_TIS. Ul
#23 Error{Li005]: no definition for "sensor_algorithm_stan_guard” [referenced from CATrustZone_|AR_Keilkeilk2 contentAR\sensor_ns\DebudhObj\Flex SoftwarelProgram Entndhal_entry.o)
#23 Error{Li005]: no definition for "sensor_algorithm_stop_guard" [referenced from CATrustZone_lAR_Keil\keiliK2 contentlAR\sensor_ns\Debug\Obj\Flex SoftwarehProgram EntnAhal_entry.o]

Figure 72. Potential Error Message
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5.5.2 Download and Debug the Application Projects
Prior to downloading and running the example project, user should first follow section 5.3 to set up the MCU.

Then, use the following steps:

1. Click on the Project tab Project > Options > Debugger > Setup and notice that
partition_device.mac is selected. This macro defines the IDAU boundary setting generated.

2. Switch to the Debugger > Images window and notice that the Secure image is also downloaded.

Options for node "sensor_algorithm_ns" X

Categony: Factory Settings

General Options
Static Analysis
Runtime Checking
C/C++ Compiler Setup Download Images Multicore Extra Options Plugins
Assembler
Output Converter
Custom Build Path: ansor,algorithm,s\Debug\Exl\sensorfalgorithmfs.ou{ I
Build Actions
Linker Offset: |0 [[] Debug info only
Debugger
Simulator
CADI
CMSIS DAP
GDB Server Debug info only
I-jet
3-Link/)-Trace [] Download extra image

[v] Download extra image

[] Download extra image

TI Stellaris
Nu-Link
PE micro Debug info only
ST-LINK
Third-Party Driver
TI MSP-FET

TI XDS

Cancel

Figure 73. Non-secure Project Debug Configuration to Download the Secure Project
3. Click Download and Debug 3
4. |If the current MCU IDAU region setup differs from the boundary calculated from the Secure project, the
window shown in Figure 74 will appear, prompting you to set up the IDAU region.

':0:' Target device needs TrustZone partition sizes to be changed before debug session can be started.

Launch the Renesas Device Partition Manager tool?

Yes No

Figure 74. Choose to Launch Renesas Device Partition Manager

Once the Renesas Device Partition Manager is launched, configure the settings as shown in Figure 75.
Use Browse to select the .rpd file generated from the secure project (sensor_s.rpd) as the input for
the User Renesas Partition Data file entry.
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B ' Renesas Device Partition Manager O

Device Family: |Renesas RA  «

Action

[[JRead current device information [[] Change debug state
ustZUne secure / non-secure boundaries [ Initialize device back to factory default
Target MCU connection: J-Link ~

Connection Type: sCl ~

Emulator Connection: Serial Mo ~

Serial No/IP Address: [ ]

Debugger supply voltage (V): ]

Connection Speed (bps for 5CI, Hz for SWD): 9600
Debug state to change to: Secure Software Development

Memory partition sizes

.Jlse Renesas Partition Data file

—IE\M)rP rojects\IAR\sensor_s\D ebug\E)IE\sensor_s.rpd I Browse...
—
Code Flash Secure (KEB) 4
Code Flash NSC (KB) 28
Data Flash Secure (KB) 0
SRAM Secure (KB) 2
SRAM NSC (KB) 6

Command line tool:

Browse...

*

! Import Export Run Close

Figure 75. Configure the Renesas Device Partition Manager
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5. Click Run to set up the IDAU region.

Device Family: |Renesas RA

Action

[JRead current device informaticn

Target MCU connection:
Connection Type:

| Emulator Connection:
Senial No/IP Address:

Debugger supply voltage (V):

Debug state to change to:

Memory partition sizes

Use Renesas Partition Data file

Set TrustZone secure / non-secure boundaries [ Initialize device back to factory default

Connection Speed (bps for 5CI, Hz for SWD): | 8600

[] Change debug state

J-Link
5Cl

Serial Mo

[ ]

0

e

Secure Software Development

| C:\MyProjects\[AR\sensor_s\DebughExe\sensor_s.rpd

Browse...

Code Flash Secure (KB) 4
Code Flash N5C (KB)
Data Flash Secure (KEB) 0
SRAM Secure (KB)

SRAM NSC (KE)

Command line tool:

[==]

Browse...

COMNMECTED.

Prg
Code Flash Secure (kB)
Code Flash N5C

Data Flash Secure  (kB)
SRAM Secure (kB)
SRAM MNSC (kB) :6

(kE)

Checking the device's TrustZone type

4
28

0
2

: SUCCESSFUL!

he following region size settings...

SUCCESSFUL
Disconnecting...

DISCONMECTED.

Ceonnection : SUCCESSFUL!
Boundary setting  : SUCCESSFUL!
EMD SUMMARY---------

SUMMARY OF RESULT------

Export Close

Figure 76. Renesas Device Partition Manager IDAU Result
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6. Click Close to close the RDPM.

7. Navigate to the EWARM IDE, click Download and Debug 3 to program the Secure and Non-secure

>

applications. When the execution stops at Reset_Handler, click the Go button to resume the

execution.
8. See section 5.4.3 to verify the functionality of the project.

5.6 Example Application with Keil MDK using Combined Development Model

The Keil MDK based projects utilize the Combined Development model. The assumption is that the Secure
and Non-secure applications are developed by one team.

Unzip Keil.zip to explore the IAR project contents.

Non-secure project «—— non_secure
Secure project — secure
Keil workspace file «—— KA sensor_trustzone

Figure 77. Keil MDK Software Project Content

5.6.1 Import and Build the Example Projects
Follow the steps below to build the Keil example projects:

1. Launch Keil MDK with Administrator authority. Right click on kA uva
2. Open the multi-project Workspace sensor_trustzone.uvmpw.

and select Run as administrator.

X
C » (G)Windows » TrustZone_lAR » Keil w [V] Search Keil 2
= I @
] Name " Date modified Type Size|
non_secure File folder
SECUre File folder
I E sensor_trustzone.uvmpw I pVision Multi-Praj...
v < >
E! | senser_trustzone.uvmpw v| All Files (*%) ~
Figure 78. Open the Keil Multi-project Workspace
3. Setthe sensor_s as the Active Project and then launch the RA Smart Configurator.
ﬂ C\TrustZone_|AR_Keil\Keil_K2_Folder\Keil\secure\sensor_s.uvprojx - pVision
File Edit View Project Flash Debug Peripherals Tools SVCS Window Help
Neda ) 3@ | | " Set-up PC-Lint...
o i i g Lint
&L E o2~ ‘ Lin?i” Target 1 ~ "
Lint All C/C++ Source Files
Project
=-E3 WorkSpace Configure Merge Tool...
2% Project: sensor_s Customize Tools Menu...
B3 T 1
1¥3 Target I RA Smart Configurator I
@-Ld Source Group 1 :
#-Ld Renesas RA Smart Configurator:=Common smart Bundle Viewer
< . Flex Software Device Partition Manager
= “% Proiect: sensor ns 1 1490 l INT
Figure 79. Launch RA Smart Configurator from Keil MDK
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4. Once the RA Smart Configurator is launched, click Generate Project Content.

5. Close the RA Smart Configurator.

6. Return to the MDK IDE, click Project->Build ‘sensor_s’.

File Edit View Project Flash Debug Peripherals Tools SVCS Wi

=" @l New pVision Project...
Mew Multi-Project Workspace...

T
Open Project...
Project R
o 08 Workspace| et
=% Project: Import
= 5o Targe Export
o= I Manage
[cR =y
@ Select Device for Target ...
=% Project: Remove Item

54 Targ: 4% Options for sensor_s - Target Target 1'..

& 9

Clean ‘sensor.s (Target 1)

Build ‘sensor_s (Target 1)

Rebuild ‘sensor_s (Target 1)°
T2 Batch Build

Figure 80. Build the Secure Project

7. The Secure project will be compiled.
8. Launch the Smart Bundle Viewer.

File Edit View Project Flash Debug Peripherals Tools SVCS Window Help

=" @‘ A Lﬁ| | San ‘ e Set-up PC-Lint...

=
Project
EREE WorkSpace
- 37 Target1
L Source Group 1

Lint

ot . LoAaD
- | 88| targetn N
Lint All C/C++ Source Files

Configure Merge Tool..,

Customize Tools Menu...

RA Smart Configurator
I Smart Bundle Viewer I

Device Partition Manager

@#-[d Renesas RA Smart Configurater:Common
@€ Flex Software

Figure 81. Launch the Smart Bundle Viewer

9. Extract the secure and non-secure region set up from the Smart Bundle Viewer.

[ ] O X
Smart Bundle Viewer
Review Renesas Smart Bundle content é
ame Start Size Core Security
v [0 RAM (20000000 040000
= RAM_CM33_S (20000000 0800 CM33 Secure
= RAM_CM33_C 020000200 Ox 1800 CM33 Men-secure Callable
~ [ FLASH (00000000  Ox 100000
= FLASH_CM33_S 000000000 On2800 CM33 Secure
= FLASH_CM33_C (500002800 (55800 CM33 Mon-secure Callable
> () DAIAFLASH 0x0B000000 . 0x2000
[0 OPTION_SETTING 0x01004100  0x100
0 OPTION_SETTING_S 001004200 0100
0 b_cope (00000000 Ox0
[J SDRAM (xB80010000  Ox0
0 QsPI_FLASH (xB0000000 04000000
0 OSPIDEVICE O (68000000 08000000
[0 OSPI_DEVICE_1 (70000000 0w 10000000

M Peripherals| Symbols|

Close

Figure 82. Smart Bundle Viewer
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10. Record the RAM_CM33_S, RAM_CM33_C, FLASH_CM33_S, FLASH_CM33_C based on Figure 82.
Convert the Size to KB.

11. Close Smart Bundle Viewer.
12. Follow section 5.3 to set up the MCU.

13. Launch Device Partition Manager and set up the IDAU region based on the result from Figure 82.

B’ Renesas Device Partition Manager O *

Device Family: | Renesas RA

Action
[ ] Read current device information [] Change debug state
I Set TrustZone secure / non-secure boundaries I:‘ Initialize device back to factery default

Target MCU connection: J-Link ~
Connection Type: SCl ~
Emulator Connection: Serial Mo ~
Serial No/IP Address: [ ]
Debugger supply voltage (V): 0

Connection Speed (bps for 5CI, Hz for SWD): | 9600
Debug state to change to: Secure Software Development

Memaory partition sizes

[] Use Renesas Partition Data file

CA\TrustZone_|AR_Keil\Keil\AR\fsp_v420\sensor_s\DebughExe\sensor_s.rpd Browse...
Code Flash Secure (KE) [10 |
Code Flash NSC (KE) [22 |
Data Flash Secure (KE) [o |
SRAM Secure (KB) [2 |
SRAM NSC (KE) [6 |

Command line tool:

Browse...
@' Import Export I Run ‘ Close
Figure 83. Set up the IDAU region
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14. Ensure that the IDAU region is successfully set up.

Checking the device's TrustZone type  : SUCCESSFUL! ~
CONMECTED.

Programming IDAU memory boundaries with the following regien size settings...
Code Flash Secure (kB) +10
Code Flash NSC (kB) :22
Data Flash Secure  (kB) 10
SRAM Secure (kB) 12
- SRAMMSC (B} :6
SUCCESSFUL!

Disconnecting...
DISCONMNECTED.

---------- SUMMARY OF RESULT----------
Connection  : SUCCESSFUL!

Boundary setting @ SUCCESSFUL!
------------- EMND SUMBMARY-------=-----

® Import Export Run Close

Figure 84. IDAU Region is Configured Correctly

15. Close the Device Partition Manager.

16. Right click on the Non-secure project sensor_ns and set it is as the Active Project.

File Edit View Project Flash Debug Peripherals Tools SVCS W

IN=A" N @& = o -5
SEHEe- W Target 1 v }:‘\ &= ¢
Project L |

= Z8 WorkSpace B
beesewars
= s Target1
+13d Seurce Group 1
# [ Renesas RA Smart ConfiguratorCommon Sources
© @ Flex Software

5 “% Project: sensor_ns
- 4 Target 1 I Set as Active Project I l
T Cmvimmm Temiim 1

Figure 85. Set the Non-secure Project as the Active Project

17. Select Tools > RA Smart Configurator.

18. Click Generate Project Content.

19. Close the RA Smart Configurator

20. Return to the Keil MDK IDE and select Project -> Build ‘sensor_ns’.

File Edit View Project Flash Debug Peripherals Tools SVCS  Window

" __,; d J New pvision Projedt...

MNew Multi-Project Workspace...

€ E & e
Open Project...
Project
= Close Project
it WorkSpace
=% Project: Import
3 Targs Export
R Manage
# 0 F
T 0 E Select Device for Target ..
=y 4 Pfojeﬂ_' Remove item

S 4 Targs ,Q\ Options for sensor_ns - Target Target 1'...
iz <

= Clean “sensor_ns (Target 1)
g W - :
L=l Bulld ‘sensor_ns (Target 1)

=i F

5 Rebuild ‘sensor_ns (Target 1)
" @& Batch Build
W

Figure 86. Build the Non-secure Project

21. The non-secure project will compile successfully with no issue.
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5.6.2 Download and Debug the Application Project
Follow the steps in this section to debug the system.

1. With sensor_ns as the Active Project, click the Start/Stop Debug Session button.

JRelalle c o @-|E-| A
i} Start/Stop Debug Session (Ctrl+F5)
Enter or leave a debug session

_] SEGGER RIT.h -~ ]

nnetion iz opnly specified for accesses to BTT buffer d

Figure 87. Start Debug with Keil MDK

2. Click Run and then follow section 5.4.3 to verify the functionality of the application project.

File Edit View Project Flash Debug Peripherals Tools SVCS  Window Help
1" IR -Y | = | & = )
FlEP 8w DR Bs o E 0 @-N-0- @8- »
Registers 1 E Disassembly
Register g2
oC 83: f/* Inmitialize system using BSP. */
e 54 SystemInit();
RO . 64: Sys Ini H
R1
Rz [] stattup.c = | ] halentryc | ] SEGGER_RTT.h ]| SEGGER_RTT|
R3 -
R4 47 H/ i : ’ ’
RS 48 * Exported glokal wvariakles (to be access)
Rs :Z .........................................
R7 )
i D[] /% Ak kR R R R R R R R R R
RY 52 # Private global wariables and functions
R10 B3 L anras R AR A A R R A A AR A AR R AR AR R AR
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Figure 88. Run the Application Project

3. Follow section 5.4.3 to verify the functionality of the example projects.

6. Appendix A: Using Renesas Flash Programmer for Production Flow

e Allinstructions in this section are based on connection to RFP using J-Link debugger over USB. For
other connections, refer to the RFP User’'s Manual for instructions.

e All the instructions provided in this section are for supporting the production flow of the e? studio example
application explained in section 5.4. The difference in the production operation between Combined
Project Development model and the Split Project Development model will be pointed out. However,
providing detailed instructions on the production flow of the Combined Project Development model is out
of scope of this application project. Users need to adjust these RFP projects with the IDAU region setup
if different projects are used.
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6.1 Initialize the MCU

Follow the steps in section 5.3 to establish the hardware connections. Then, launch RFP, open
“\RFP_projects\initialize _mcu\initialize _mcu.rpj”, go to the tab Device Information, and
select Initialize Device.

File | Target Device '_ Help
Operat Read Device Information =
Read Memory...

Pri Read Flash QOptions

(] Iinitialize Device ||
L DLM Transition...

Figure 89. Initialize using RFP

Signature: ~
Device: RIFAGMAAFICFE
Eoot Firmware Version: W1.6.25
Device Unique I0: 4E4B29716CDAIEEIIE3636345611762B
Device Code: 01
Current state: 55D
SECDBG Key Injection: Mo
NOMSECDBEG Key Ihjection: Mo
R Key Injection: Mo

Erasing the target device

Digconnecting the tool
Operation completed.

Clear status and message

Figure 90. MCU is Successfully Initialized

6.2 Download the Secure Binary

Open the attached RFP project
\RFP_projects\pre_programmed_sensor_algorithm_s\pre_programmed_sensor_algorithm_
s.rpj to perform the following functions:

e Program the Secure binary.
e Set up IDAU regions.
e Transition to NSECSD.

Note that the demonstration in this section is based on the configuration in the e? studio projects
demonstrated in section 5.4.

Figure 91 shows the settings for the Operation Settings tab:

e Choose Program and Verify so that the Secure binary can be programmed and verified.

e Choose Program Flash Option and Verify Flash Option so that the IDAU and device lifecycle state
can be set up and verified.

e Erase is not selected as this has been taken care of with the Initialize command as shown in section 6.1.

Device Information  Help

Operationl] Operation Settingsll Block Settings Flash Options  Connect Settings  Unique Code  User Keys

Command Erase Options

[ e Erase All Blocks ~
]

FEiEs Program & Venfy Options

Verty [] Erase Before Program

]

AR REEUELITE Verify by reading the device

[ Checksum

Checksum Type
CRC-32 method

Fill with GxFF

[ Code Rash # User Boot Enor Settings

[] Data Flash Enable address check of program file

Figure 91. Set up Operation Settings (RFP)
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Figure 92 shows the setup for the DLM state transition and IDAU region setup for this example application.

Note: With RFP, you can directly transition the MCU device lifecycle state from SSD to NSECSD without

needing to download the dummy Non-secure binary. The dummy Non-secure binary is only needed
for starting Non-secure project development.

File  Target Device Help

Operation Operation Settings Block Settings Connea Settings Unique Code  User Keys

v _DLM

Set Option Set
Target State NSECSD
v

Set Option Do Nothing

Set Option
Use Renesas Partition Data File
Code Fash Secure [KB]

Code Fash NSC [KB]

Data Fash Secure [KB]

SRAM Secure [KB]

SRAM NSC [KB]

62 ity

G 1

NS NGO
~

Set Option Do Nothing
L No

Disable Inttialize Command

Figure 92. Setup for the IDAU Region

Settings for the connection interface are shown in Figure 93.

File  Device Information  Help

Operation Operation Settings  Block Settings  Flash Options nique Code User Keys

Communication
Toaol: Interface: 2 wire UART Speed: | 9,600 ~ | bps
Tool Details... MNum: AutoSelect
Device Authentication
Settings...

Figure 93. Setup for the Connection

Select the Secure project binary (.srec or .hex) generated in to be programmed into the MCU. Select the
binary generated from section 5.4.1.2.

Operation hperaﬂon Settings  Block Settings Flash Options  Connect Settings  Unigue Code  User Keys

Project Information

Cumrent Project: test mj
Microcontroller: R7FAGMAAF3ICFB
Program File

I|nn_tz\preprogramrned_sensor_algomhm_s\Debug\prejrogrammed_sensor_algorithm_s.sredl Browse...

CRC-32 : 73B40EFB
Flash Operation

Program == Verfy >> Program Flash Options > Verify Flash Options

Start

Figure 94. Select the Secure Binary to Program into the MCU

With all settings in place, click Start to download the Secure binary and set up the IDAU region.
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6.3 Download the Non-secure Binary

Use RFP to download the Non-secure project binaries using the provided RFP project:
\RFP_projects\pre_programmed_sensor_algorithm_ns\pre_programmed_sensor_algorithm

_ns.rpj.

Check Program Flash and Verify Flash, uncheck Program Flash Option and Verify Flash Option from

the Operation Settings tab.

File  Device Information  Help

Command

[] Erase

Program

Verfy

[] Program Flash Options
[] Verfy Flash Options
[] Checksum

Fill with CeFF
[] Code Aash # User Boot
[] Data Flash

Operation| Operation Settings [Block Settings Flash Options  Cornect Seftings  Unique Code  User Keys

Erase Options
Erase Selected Blocks ~

Program & Verify Options
[] Erase Before Program

Verify by reading the device

Checksum Type
CRC-32 method

Emor Settings
Enable address check of program file

Figure 95. Operation Settings for Non-secure Project Binary Download

Transition to DPL is not selected. Change from Do Nothing to Set in production flow. Once the device
lifecycle state is transitioned to DPL, the JTAG interface will be disabled (ho SEGGER RTT Viewer

input/output functionality).

v DLM

Operation Operation Settings  Block Settings | Fash Options IConnect Settings  Unique Code  User Keys

Set Option
Target State

Do Mething
DPL

v DLM Keys
Set Option
Encrypted SECDBG Key
Encrypted NOMSECDBG Key
Encrvpted BMA Key

Do Mathing

] Boundary

Set Option

Code Fash Secure [KB]
Code Fash NSC [KB]
Data Fash Secure [KB]
SRAM Secure [KB]
SRAM N5C [KE]

Do Mothing

[ R Y T |

v  Security
Set Option
Dizable Initialize Command

Do Mothing
Mo

Figure 96. Operation Settings for Non-secure Project Binary Download
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The Connect Settings should use the same setup as shown in Figure 93.

Select the Non-secure binary generated from section 5.4.2.2.

File  Device Information  Help

Operation  Qperation Settings  Block Settings  Flash Options  Connect Settings  Unique Code  User Keys

Project Information

Cument Project: test.pj
Microcontroller: R7FAEM4AF3ICFB
Program File
ll;ecure project‘-.pregrogrammed_sensor_algomhm_ns\F{elease\prejrogrammed_sensor_algb| Browse... I
CRC-32 : 75587364
Flash Operation
Program == Verify

Figure 97. Select the Non-secure Binary
With all the above settings, click Start to download the Non-secure binary.

The production flow of the IP protection use case also requires advancing the device lifecycle state from DPL
to LCK_DBG or LCK_BOOT. However, once the device lifecycle state advances to LCK_DBG, the debug
interface will be permanently locked. Once the device lifecycle state advances to LCK_BOOT, the serial
programming interface will be permanently locked. To avoid accidental MCU debug and serial programming
interface locking, do not transition the device lifecycle state to LCK_DBG or LCK_BOOT unless you are
doing so for production usage.
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6.4 Specific Instructions to Support IAR EWARM Development Path

6.4.1 IAR I-jet and TrustZone® Partition Boundary Setup
IAR’s I-jet debug probe does not provide support for setting the TrustZone partition boundaries, as it does
not have the ability to interface with the RA MCU’s boot mode through the debug header.

It is therefore necessary to set the TrustZone partition boundaries appropriately using alternative means
before debugging through I-jet. Typically, this will need to be done using an SCI connection to the
board/MCU and the Renesas Flash Programmer (RFP) application available from:

https://www.renesas.com/us/en/software-tool/renesas-flash-programmer-programming-qui

Figure 98 shows RFP configured to read the TrustZone partition boundaries from a . rpd file.

File  Target Device  Help

Operation  Operation Settings  Block Settings  Flash Options  Connect Settings  Unigue Code  User Keys

v DLM
Set Option Do Mothing
Target State 55D

v DLM Keys
Set Option Do Nothing

Encrypted SECDBG Key
Encrypted NONSECDBG Key

Encrypted RMA Key
~ Boundary

Set Ciption Set

Use Renesas Partition Data File Yes

C:\demo_iar\demo\Debug\Exe\demo rpd
v Security

Set Option Do Nothing

Dizable Inttialize Command No

Clear status and message

Figure 98. Configure TrustZone® Partition

6.4.2 CMSIS-DAP and Trust Zone Partition Boundary Setup

EWARM also supports the use of CMSIS-DAP based debug probes. These do not have the ability to
interface with the RA MCU’s boot mode through the debug header.
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7. Appendix B: Glossary

Term Meaning

SSD Device Lifecycle State: Secure Software Development. Debugging level is DBG2. IDAU
region can be set up in this state.

NSECSD | Device Lifecycle State: Non-SECure Software Development. Debugging level is DBG1.

DPL Device Lifecycle State: DePLoyed. Debugging Level is DBGO.

SCE9 Secure Crypto Engine 9: An isolated subsystem within the MCU protected by an Access
Management Circuit. Performs Cryptographic operations.

o
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9. Website and Support

Visit the following URLSs to learn about the RA family of microcontrollers, download tools and documentation,
and get support.

EK-RA6M4 Resources renesas.com/ra/ek-rabm4
RA Product Information renesas.com/ra
Flexible Software Package (FSP) renesas.com/ra/fsp
RA Product Support Forum renesas.com/ra/forum
Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external
reset pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states
of pins in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power

reaches the level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity
of the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between V. (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in
terms of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic
values, operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a
system-evaluation test for the given product.
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1.
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11.

12.

13.
14.

(Notel)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quiality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan
www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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